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Community Place Conductorについて
Community Place Conductorについて

Community Place™ Conductor 2.0（以下、Conductorと呼びます。）は、VRML97に
対応したオーサリングツールです。
Conductorには、以下のような特長があります。

VRML97対応
ドラッグ＆ドロップによるノードの追加
ノード属性の数値入力機能
音、物体のテクスチャーの定義が可能
実行モードと編集モードの切り替えが可能
Java™対応（JRE1.1.3以降あるいは、JDK1.1.3以降が必要です。）
スコープの切り替え、スコープ単位の編集が可能
スクリプトノードを自動作成できるスクリプトエキスパート機能
ビジュアルなルーティング表示、追加、削除
キーフレームアニメーション（Interpolator）編集機能
PROTO編集機能
USEのサポート

このマニュアルでは個々の機能について解説します。Conductorを使用してワー
ルドを作成する方法については、チュートリアルをご覧ください。

本文中のイタリック文字（例 color）は、VRML のフィールド名を、ボールド文
字（例 value=32 ）は、プログラムの一部を示しています。詳しくは、巻末に挙
げる参考文献をご覧ください。
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Community Place Conductorについて
■■■■インストールインストールインストールインストール
Conductorを実行するには、システムが以下の条件を満たしているかどうか
確認してください。

（注 1） ヘルプの表示や、Anchorの表示を行う際に必要です。
（注 2） Javaを使用したコンテンツの作成を行う場合に必要です。

（注）一部のハードウェアでは正しく動作しない場合があります。詳しくは、オン
ラインの制限事項（Conductorをインストールしたフォルダの
doc¥restrict¥restrict-j.txt）をお読みください。

インストールを行うには、setup.exe（CD-ROM を読み込んだ際に自動的に起
動します）を起動してインストールを行ってください。

表 1  使用環境

推推推推奨環奨環奨環奨環境境境境

Hardware
Windows® 95/98、Windows NT® 4.0以上の稼動してい
る PC/AT互換機

CPU Pentium® 90MHz以上

メモリー 32MB以上

空きディスク容量 20MB以上（インストール時には 40MB必要）

画面解像度 800x600ピクセル以上

表示色数 65536色以上

ソフトウェア
Netscape Navigator™ for Windows （ver 3.0 以降）または、
Microsoft® Internet Explorer （ver 3.0 以降）（注 1）

JAVA™（注 2） JDK1.1.3以降

サウンド サウンドボード +スピーカーまたはヘッドホン
2



Community Place Conductorについて
■■■■アンインストールアンインストールアンインストールアンインストール
アンインストールするには、スタートメニューから、プログラム→
Community Place Conductor→ Uninstallを選択します。

（注）アンインストールしたあとでも、インストール後作成したファイルや一時ファ
イルなどが残ることがあります。アンインストール実行後に Conductorのディ
レクトリが残っていたらすべて削除してください。Conductorを再インストー
ルする際には、Conductorのディレクトリがすべて削除されていることを確認
してから、インストールすることをお勧めします。

■■■■ Conductor の起動と終了の起動と終了の起動と終了の起動と終了

••••     起動起動起動起動方方方方法法法法
スタートメニューから、プログラム→ Community Place Conductor→
Community Place Conductorを選択します。
ワールドを新規に作成するには、File→Newメニューを選択してください。
既存の VRML97ファイルを読み込むには、File→ Openメニューを選択し
てください。

（注）VRML1.0には対応しておりません。ファイルが VRML1.0 の場合は、あらかじ
め、Conducotr 2.0 CD-ROMの中に収められている vrml1to2で、VRML2.0に
変換しておいてください。

••••     終了終了終了終了方方方方法法法法
メニューから File→ Exitを選択するか、Mainウィンドウ右上の×ボタン
をクリックすることで終了させることができます。ファイルが変更されて
いる場合には、保存を促すダイアログが表示されます。
3



Community Place Conductorについて
■■■■ Conductor の各ウィンドウの機能の各ウィンドウの機能の各ウィンドウの機能の各ウィンドウの機能
Mainウィンドウ ：Conductor全体の管理を行います。
3D Perspective Viewウインドウ ：透視投影で物体を表示します。
Appearanceウィンドウ ：オブジェクトの外観を設定します。
Attributeウィンドウ ：ノードの属性を設定します。
Keyframe Editorウィンドウ ：Interpolatorの編集を行います。
Libraryウィンドウ ：ライブラリの管理をします。
Messageウィンドウ ：各種メッセージを表示します。
Multi Userウィンドウ ：マルチユーザーワールドを設定します。
Parallel Viewウィンドウ ：平行投影で物体を表示します。
Routeウィンドウ ：イベントのルーティングを設定します。
Scene Graphウィンドウ ：ワールドのツリー構造を表示します。
Script Expertウィンドウ ：スクリプトのひな形を作成します。
Text Editorウィンドウ ：Javaファイルを編集する時に使います。
Textrure Mappingウィンドウ ：Texture Mappingの編集を行います。

各ウィンドウは必要に応じて表示したり、閉じておくことができます。

図 1  Conductor を使用している様子
4



Community Place Conductorについて
■■■■リファレンスリファレンスリファレンスリファレンス
VRML97仕様

http://vag.vrml.org/VRML97/

Virtual Society on the Webホームページ
http://vs.sony.co.jp/
5
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第 1章  Main ウィンドウ
第 1章  Main ウィンドウ

図 2 に示す Main ウィンドウでは、ワールドの新規作成、読込み、保存、実行、
停止、マウスモードの切り替え、キーフレーム編集モードの切り替え、ノードの
追加、削除などを行います。

図 2  Mainウィンドウ

■■■■ File メニューメニューメニューメニュー

••••     New
新規にワールドを作成します。
3D Perspective Viewウィンドウ（以下 3D Viewウィンドウ）などのワール
ドを操作するためのウィンドウが表示されます。

••••     Open、、、、Reopen

VRML ファイルをロードします。 （Openボタン）を押しても同じ動
作をします。ファイルオープンダイアログが表示されますので、読み込み
たいワールドのファイルを選択してください。
以前に読み込んだことのあるファイルを読み込むには、File メニューの
Reopenでファイルの一覧が表示されますので、読み込むファイルを選ん
でください。

Open、Reopenの他にも、以下の方法でファイルを開くことができます。ただし、い
ずれの方法も VRML ファイルのショートカットには対応してません。
- Conductorのアイコンに VRML ファイルをドロップする。
- Conductorを起動しておいて、Mainウィンドウに VRML ファイルをドロップする。
- コマンドラインによりロードする。（例えば、cpcondct foo.wrl）
6



第 1章  Main ウィンドウ
（注）VRML1.0には対応しておりません。ファイルが VRML1.0 の場合は、あらかじ
め、Conducotr 2.0 CD-ROMの中に収められている vrml1to2で、VRML2.0に
変換しておいてください。

••••     Save

ワールドをファイルに保存します。 （Saveボタン）を押しても同じ
動作をします。

••••     Save As
ワールドを別ファイルに保存します。ファイル保存のダイアログが表示さ
れますので、ファイル名を入力してください。

••••     Close
編集中のワールドを閉じます。

••••     Exit
Conductorを終了します。

ワールドが変更されている場合は、保存するか確認してきますので、保存
する場合は「はい」を選択してください。

（注）起動時、終了時にテンポラリディレクトリ（デフォルトは、
"C:¥ProgramFiles¥Sony ¥Community Place Conductor ¥tmp"）内にあるファ
イルはすべて削除されますので、テンポラリディレクトリにファイルを保存
しないでください。

■■■■ Edit メニメニメニメニュュュューーーー

••••     Undo
操作を取り消して元の状態に戻します。Ctrl+zでも同じ動作をします。

（注）Undo は何度も実行することができますが、機能によっては Undo できないも
のもあります。
例えば、Object Customize Wizard による属性の編集は Undo することができ
ません。

••••     Redo
Undoを取り消します。Shift+Ctrl+zでも同じ動作をします。Redoは Undo
を行った直後にのみ有効です。
7



第 1章  Main ウィンドウ
••••     Cut
選択されているノードを削除します。Ctrl+xでも同じ動作をします。ノー
ドの選択は、2D/3D Viewウィンドウ、または Scene Graphウィンドウから
行います。削除されたノードは、ペーストすることができます。

••••     Copy
選択されているノードをコピーします。Ctrl+cでも同じ動作をします。コ
ピーされたノードは、ペーストすることができます。

••••     Paste
Cut または、Copy バッファ中のノードを選択されているノードにペース
トします。ペーストできない場合（例えば、ノードの型が一致しない場
合）には、警告メッセージが表示されます。

••••     Delete
選択されているノードを削除します。

••••     Keyframe
Interpolatorノードを編集するための Keyframe Editorウィンドウを表示し
ます。
詳しい操作方法については、「第 5 章 Keyframe Editor」（32 ページ）をご
覧ください。

■■■■ View メニューメニューメニューメニュー
各ウィンドウを表示します。現在表示されているウィンドウのメニュー項
目にはチェックマークが付きます。

■■■■ Run メニューメニューメニューメニュー

••••     Run
ワールドを実行し、動きを確認することができます。確認は、3D View

ウィンドウで行います。 （Playボタン）を押しても同じ動作をします。

（注）Run の状態では、Main ウィンドウ、2D/3D View ウィンドウ、Message ウィ
ンドウ、Java Consoleウィンドウのみ使うことができます。
8



第 1章  Main ウィンドウ
••••     Pause

実行を一時停止します。 （Pauseボタン）を押しても同じ動作をしま
す。もう一度 Pauseボタンを押すか、Playボタンを押すと実行が再開され
ます。

••••     Stop

実行を中止し、編集モードに戻ります。 （Stopボタン）を押しても同
じ動作をします。

■■■■ Script メニューメニューメニューメニュー

••••     Expert
Scriptのひな形を作成するための、Script Expertウィンドウを起動します。
詳しい操作方法については「第 12章 Script Expertウィンドウ」（67 ペー
ジ）をご覧ください。

••••     Build
変更があったスクリプトファイルのみをコンパイルします。

••••     Rebuild
すべてのスクリプトファイルを再コンパイルします。

（注）Script メニューは JDK1.1.x がインストールされている場合にのみ使うことが
できます。JDK1.2.xには対応しておりません。

■■■■ Options メニューメニューメニューメニュー

••••     Environment
環境設定ダイアログボックスが表示されます。
タブをクリックすることにより、以下の設定項目を切り替えることができ
ます。
9



第 1章  Main ウィンドウ
Generalページ

図 3  Generalページ

Blink bounding box when selected：
オブジェクトを選択しているとき、オブジェクトを囲むバウンディン
グボックスを点滅させるかどうかを設定します。

Show all nodes in Keyframe Editor source：
Keyframe Editorのソース選択コンボボックスに、指定できるすべての
ノードを表示させるかどうかを設定します。
10



第 1章  Main ウィンドウ
Gridページ

図 4  Gridページ

Show grid in view window：
2D/3D View ウィンドウに、グリッドラインを表示させるかどうかを
設定します。
表示させる場合は、グリッドの間隔と範囲をスライダーバーもしくは
数値入力により、それぞれ設定することができます。
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第 1章  Main ウィンドウ
Editorページ

図 5  Editorページ

Text Editor 内の Tab の文字数、書式設定として、Font、Size、カテゴ
リー（通常のテキスト、キーワード、コメント、背景色）毎の色を設
定することができます。

■■■■ Help メニューメニューメニューメニュー

••••     VRML97 Spec
VRML97関するスペックを HTML ブラウザー上に表示させます。

（注 1） 表示を行うためには、Netscape Navigator 3.0以降、または、Microsoft Internet
Explorer 3.0 以降が必要です。

（注 2） VRML97 オンラインマニュアルの Copyright については、Conductor をイン
ストールしたフォルダ内の doc¥vrml97¥copyright.htmlをお読みください。

（注 3） Netscape Navigatorまたは、Microsoft Internet Explorerを起動していない状
態で Help メニューを選択した場合には、ブラウザを起動するだけで、ヘル
プは表示されません。ヘルプを表示するには、Helpメニューを再度選択し直
してください。
12



第 1章  Main ウィンドウ
••••     Show CLASSPATH
Sunの JRE 1.1.xあるいは JDK 1.1.xがインストールされている場合に、ク
ラスパス情報を表示します。

（注 1） JRE/JDKが検出されない場合には、クラスパス情報は表示されません。
（注 2） スクリプトをコンパイルする場合には JDKが必要です。JRE/JDKはバージョ

ン 1.1.xをインストールしてください。JDK1.2.xには対応しておりません。

••••     About
図 6に示す Aboutダイアログボックスを表示します。このダイアログボッ
クスには、Conductorのバージョンや、Conductorが認識した Javaに関す
る情報が表示されます。

図 6  Aboutダイアログボックス
13



第 1章  Main ウィンドウ
■■■■マウスモードマウスモードマウスモードマウスモード
Conductorでは以下のマウスモードボタンがあります。

（注）マウスモードは Walk、Examine、Move、Rotate、Scale のいずれかの状態に
なります。Examineに関しては「Mouse Mode」（22 ページ）をご覧ください。

オブジェクトの移動、回転、スケールの変更は選択されているオブジェクト
に対して行われます。オブジェクトの選択は、Viewウィンドウ、または Scene
Graphウィンドウから行います。選択するとオブジェクトを囲むバウンディ
ングボックスが表示されます。

■■■■ツールバーツールバーツールバーツールバー
ワールドにジオメトリやセンサーなどのノードを追加するには、図 7のツー
ルバーで追加したいノードのボタンを押し、3D Viewウィンドウをクリック
します。（実際の使い方については、チュートリアルを参照して下さい）

図 7  ツールバー

表 2  マウスモード

ボボボボタンタンタンタン 機機機機能能能能

Walk 2D/3D Viewウィンドウにおける視点の移動

Move オブジェクトの移動

Rotate オブジェクトの回転

Scale オブジェクトのスケール変更
14
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表 3  Geometory 

ボボボボタンタンタンタン ノーノーノーノードドドド

Box 立方体

Cone 円錐

Cylinder 円柱

Sphere 球

Text 文字

IndexedFaceSet
多面体（Conductorでは四角形のみ生成できま
す）

ElevationGlid
地表の様な凹凸面（Conductorでは平面のみ生
成できます）

Extrusion
平面形状の押し出しにより生成される立体
（Conductor では直方体のみ生成できます）

表 4  Sensor

ボボボボタンタンタンタン ノーノーノーノードドドド

ProximitySensor 領域内に視点が含まれるか検出するセンサー

TimeSensor 時間に関するセンサー

TouchSensor
オブジェクトのヒット（マウスによるクリック
など）を検出するセンサー

PlaneSensor
ドラッグした距離をローカル座標系における
xy平面上の移動量として検出するセンサー

SphereSensor
ドラッグした距離を回転量として検出するセ
ンサー

VisibilitySensor
領域が可視範囲に含まれるかを検出するセン
サー
15
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表 5  Common

ボボボボタンタンタンタン ノーノーノーノードドドド

DirectionalLight 平行光源

PointLight 点光源

SpotLight スポットライト

WorldInfo ワールド情報

表 6  Bindable

ボボボボタンタンタンタン ノーノーノーノードドドド

Fog フォグ

Viewpoint 視点

Background 背景

NavigationInfo ナビゲーション情報

表 7  Group

ボボボボタンタンタンタン ノーノーノーノードドドド

Anchor URLへのリンク

Billboard
視点に対して特定の方向を保つようにオブ
ジェクトを自動的に回転させる

Collsion 視点とオブジェクトの衝突を行うグループ

Group グループ

Transform ローカル座標系の定義

Inline 他のファイルからのデータの読み込み
16



第 2章  3D Perspective View ウィンドウ
第 2章  3D Perspective View ウィンドウ

図 8に示す 3D Perspective Viewウィンドウ（以下 3D Viewウィンドウ）では、オ
ブジェクトを 3D透視投影のサーフェイスモデルで表示します。

図 8  3D Viewウィンドウ

■■■■ VRML ファイルの読み込みファイルの読み込みファイルの読み込みファイルの読み込み
3D Viewウィンドウに VRML ファイルをドロップすることで，オブジェクト
をシーンに追加することができます。

（注）3D View ウィンドウにファイルをドロップする場合、いくつかの制限がありま
す。詳しくはオンラインの制限事項（Conductorをインストールしたフォルダ
内の doc¥restrict¥restrict-j.txt）をご覧ください。
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第 2章  3D Perspective View ウィンドウ
■■■■オブジェクトの選択オブジェクトの選択オブジェクトの選択オブジェクトの選択
オブジェクトをマウスでクリックすると、選択されたオブジェクトを囲むバ
ウンディングボックスと、そのオブジェクトのローカル座標軸が表示されま
す。X 軸が赤、Y 軸が緑、Z軸が青で、矢印が各々の正方向を表します。

■■■■視点位置と視線方向の表示視点位置と視線方向の表示視点位置と視線方向の表示視点位置と視線方向の表示
視点位置と方向は，左下隅のパネル（視点位置表示パネル）に数値で表示さ
れます。
このパネルをクリックすることにより表 8の様に表示を切り替えることがで
きます。

■■■■オブジェクトの生成オブジェクトの生成オブジェクトの生成オブジェクトの生成
オブジェクトの生成は、Mainウインドウのボタンによる生成や Libraryウイ
ンドウからのドラッグ＆ドロップで行うことができます。
生成される位置は、マウスポインターの位置に関係無く常に、視点位置の前
方に 10ｍ 先の位置に生成されます。目の前に生成されるので、3D View ウ
インドウの中心に表示されます。

••••     Main ウウウウィンィンィンィンドドドドウかウかウかウかららららのノのノのノのノーーーードのドのドのドの生生生生成方成方成方成方法法法法
1. Mainウインドウのツールバーから生成したいノードを選択する。
2. 生成したいノードのボタンをクリックする。
クリックしたボタンが黄色に変わり、押し込まれた状態になります。

3. マウスポインターを 3D Viewウインドウ上に移動させる。
マウスポインターの形状が変わります。

4. その状態でクリックする。
選択したノードが生成されます。

表 8  視点位置表示パネルに表示されるパラメーター

表示表示表示表示内内内内容容容容 パラパラパラパラメメメメーターターターターーーー 数値数値数値数値例例例例

ワールド座標系での視点位置 （P x, y, z）

視点と選択ノード中心までの
距離

（D    d   ）

ワールド座標系での視線方向 （V x, y, z）
18



第 2章  3D Perspective View ウィンドウ
（注 1） ノードによってその下にオブジェクトを追加できるものとできないものがあ
ります。オブジェクトを生成する際には、その時選択されているノードを確
認してください。

（注 2） ジオメトリや光源など Transformと共に生成されるノードは 3D Viewウィン
ドウに表示あるいは、反映されますが、センサーやスクリプトなど不可視の
ノードを生成しても 3D Viewウィンドウには表示されません。Scene Graph
ウィンドウには生成されたノードが表示されます。

■■■■ナビゲーションの方法ナビゲーションの方法ナビゲーションの方法ナビゲーションの方法
3D View ウィンドウでの視点の移動は、Main ウィンドウでマウスモード

を  Walk にして行います。マウスの左ボタンでドラッグするか、キー
ボードの矢印キーを使って、ナビゲーションします。

（注 1） 視点位置の Y座標のみ変化します。
（注 2） 視点位置の Y 座標は不変で、X、Z 座標は、視線方向に垂直な面上をスライ

ドします。

表 9  ナビゲーション

動動動動きききき 修修修修飾キ飾キ飾キ飾キーーーー ドラドラドラドラッッッッグ方グ方グ方グ方向向向向 キーキーキーキー 視視視視点位点位点位点位置置置置
視視視視線線線線
方方方方向向向向

前方移動 上 ↑ 移動 不変

後方移動 下 ↓ 移動 不変

右へ回る 右 → 不変 移動

左へ回る 左 ← 不変 移動

上方移動 Shift 上 ↑ 移動（注 1） 不変

下方移動 Shift 下 ↓ 移動（注 1） 不変

右方移動 Shift 右 → 移動（注 2） 不変

左方移動 Shift 左 ← 移動（注 2） 不変

上を向く Shift + Ctrl 上 ↑ 不変 移動

下を向く Shift + Ctrl 下 ↓ 不変 移動
19



第 2章  3D Perspective View ウィンドウ
■■■■オブジェクトの移動オブジェクトの移動オブジェクトの移動オブジェクトの移動
3D Viewウィンドウ上でのオブジェクトの移動は、Mainウィンドウでマウス

モードを Moveにして行います。
対象となるオブジェクトを選択し、オブジェクトを囲むバンディングボック
スをドラッグすることで移動させることができます。
オブジェクトの移動は、ドラッグを開始する際に選択したバンディングボッ
クスの面に沿った移動になります。

（注）View ウィンドウ上で、オブジェクトが遠方にある場合には、オブジェクトを
囲むボックスを選択できないことがあります。

■■■■オブジェクトの回転オブジェクトの回転オブジェクトの回転オブジェクトの回転
3D Viewウィンドウ上でのオブジェクトの回転は、Mainウィンドウでマウス

モードを Rotateにして行います。
対象となるオブジェクトを選択し、バンディングボックスをドラッグするこ
とで回転させることができます。
オブジェクトの回転は、オブジェクトの中心周りの回転になります。

■■■■オブジェクトのスケーリングオブジェクトのスケーリングオブジェクトのスケーリングオブジェクトのスケーリング
3DView上でのオブジェクトのスケーリングには、Mainウィンドウでマウス

モードを Scaleにして行います。
対象となるオブジェクトを選択し、バンディングボックスをドラッグするこ
とでスケーリングすることができます。
オブジェクトのスケーリングは、オブジェクトの中心を原点としたものにな
ります。

（注）マウスによるスケーリングは、等方スケーリングのみとなります。
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第 2章  3D Perspective View ウィンドウ
■■■■ポップアップメニューポップアップメニューポップアップメニューポップアップメニュー
図 9に示すポップアップメニューは、3D Viewウィンドウ上でマウスの右ボ
タンをクリックすると表示されます。

図 9  3D Viewウィンドウでのポップアップメニュー

ポップアップメニューは以下のサブメニューで構成されます。

••••     Home Position
自分がどこにいるかわからなくなった時や、開始位置に戻りたい場合に使
用します。

（注）VRML ファイル内に Viewpoint ノードが存在する場合、最初の Viewpoint が
Home Position となります。存在しない場合には、位置（0, 1.6, 10）が
HomePositionに対応します。

••••     Reset Tilt
視線方向を水平状態に戻します。
21



第 2章  3D Perspective View ウィンドウ
••••     Mouse Mode
マウスモード（Walk、Examine、Move、Rotate、Scale）を変更するための
メニューです。マウスモードはキー操作でも変更することができます。そ
れぞれ、W、E、V、R、Sキーに割り当てられています。

Examine
選択したオブジェクトを観察するときに使用します。3D Viewウィンドウ
でのみ使用できます。
以下の手順に従って操作します。

1. ウィンドウでマウスモードを Walkにする。
2. 観察したいオブジェクトを選択する。
3. ポップアップメニューの Mouse Mode→ Examineを選択する。

（注 1） Examine できるオブジェクトが選択されている時にのみ使用できます。
Examine モード中に、他のオブジェクトを選択することもできます。

Examineモードになり、選択したオブジェクトがウィンドウの中心に
来るように視線方向が変わります。

（注 2） 上下にドラッグしながら、シフトキーを押すとオブジェクトまでの距離が変
化します。

4. オブジェクトの周りでマウスの左ボタンを押しながらドラッグする。
マウスの動きに応じて視点位置、視線方向が変わり、さまざまな角度
からオブジェクトを観察することができます。

（注 3） Examine モード中は、3D View では通常のナビゲーションはできません。
Parallel Viewでは、ナビゲーションのみ可能です。

Examineを終了するには、再度ポップアップメニューで Examineもしくは
他のマウスモードを選びます。

••••     Viewpoint
ワールドに存在するすべての Viewpointノードが表示されます。表示され
た Viewpointを選択することにより、指定した場所に移動することができ
ます。

（注）Viewpointメニューには descriptionで指定された文字列が表示されます。    File
→ Newで作成した場合には Viewpointは設定されていません。
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第 2章  3D Perspective View ウィンドウ
••••     Adjust Viewpoint
選択されている Viewpointを、現在の視点の位置と方向にあわせます。そ
の結果、Viewpointの positionと orientationの値を調整することができま
す。このメニューは、Viewpointが選択されている時にのみ使用できます。
23



第 3章  Appearance ウィンドウ
第 3章  Appearance ウィンドウ

Appearanceウィンドウでは、選択されているオブジェクトの色やテクスチャーの
設定を行います。このウィンドウでは、Appearanceノードに含まれる Material
ノード、ImageTextureノード、TextureTransformノードの編集を行うことができま
す。各ノードの使い方については、HelpメニューのVRML97 Specをご覧ください。

■■■■ Material ノードの編集ノードの編集ノードの編集ノードの編集
materialタブをクリックすると、図 10に示すmaterialページが表示されます。
ここでは、Materialノードの DEF名と属性を設定することができます。

（注）DEF名は DEF名編集エリアに入力後、Enterキーを押すことで確定されます。

図 10  materialタブが選択されている様子
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第 3章  Appearance ウィンドウ
••••     ColorMap ダイダイダイダイアアアアログログログログボボボボックックックックススススを使を使を使を使っっっった色た色た色た色設設設設定定定定
ダイアログボックスを使って各色を設定することができます。それぞれの
色（diffuse、emissive、specular）の右隣にある長方形の部分をクリックす
ることで、図 11に示す ColorMapダイアログボックスが起動します。左
側のカラーパネル上でマウスをドラッグすることにより、色相（H）と彩
度（S）を、スライダーバーを動かすことにより明度（V）を設定するこ
とができます。

図 11  ColorMapダイアログボックス

■■■■ Texture ノードの編集ノードの編集ノードの編集ノードの編集
textureタブをクリックすることで図12に示す textureページが表示されます。
ここでは、ImageTextureノードの DEF名と属性を設定することができます。

図 12  texture タブを選択した様子

（注 1） MovieTexture、PixelTextureノードには対応していません。
25



第 3章  Appearance ウィンドウ
（注 2） DEF名はDEF名編集エリアに入力後、Enterキーを押すことで確定されます。

Local は実際のテクスチャファイルがある場所を示しています。通常は
URL で指定した場所（相対 URL 形式で記述された場合には、絶対 URL
形式に変換したもの）と Localは同じになりますが、Library ウィンドウか
らドロップした直後では、Libraryのディレクトリを指しています。

SaveあるいはSave Asした場合はURLで指定した場所にファイルがコピー
されるため、URL と Local は同じファイルを参照することになります。
Localは textureページのChoose Fileボタンを押すことで変更することがで
きます。

■■■■ TextureTransform ノードの編集ノードの編集ノードの編集ノードの編集
textureTransformタブをクリックすることで図 13に示す textureTransformペー
ジが表示されます。
ここでは、TextureTransformノードの DEF名、テクスチャをマッピングする
際の移動、回転、スケールなどのパラメーターを設定します。

（注）DEF名は DEF名編集エリアに入力後、Enterキーを押すことで確定されます。

図 13  texture Transform タブを選択した様子
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第 4章  Attributeウィンドウ

図 14に示す Attributeウィンドウでは、選択されているノードの属性と DEF名を
設定することができます。ウィンドウの下にあるステータスバーにはマウスポイ
ンター上にあるフィールドに関する、種類、変数の型、ノードの名前が表示され
ます。

図 14  Attributeウィンドウ

フィールド名の右側に表示されているアイコンは、表 10に示すようにフィール
ドの種類を表しています。
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第 4章  Attributeウィンドウ
（注）eventIn、eventOut は Script ノードと Proto インスタンスに対してのみ表示さ
れます。

■■■■ DEF名の編集名の編集名の編集名の編集
DEF名は、イベントをルーティングする際や USEを使ってノードを生成す
る際に使用します。

（注）DEF名は DEF名編集エリアに入力後、Enterキーを押すことで確定されます。

■■■■属性の編集属性の編集属性の編集属性の編集
属性値の型は、数値型、文字列型、Color 型、BOOL 型の 4 種類があり、
VRML97が規定する fieldの型に対応しています。

BOOL型を編集するには、「TRUE」または「FALSE」と表示されているエリ
アをダブルクリックして値を変更します。

編集エリアに「（SFColor）」と表示されているものは、Color型です。
そのエリアをダブルクリックすると、ColorMapダイアログが表示されます
ので、色を設定し、OKボタンを押してください。

それ以外の型のフィールドは編集エリアに値を入力し、Enterキーまたは上
下矢印キーを押すとワールドに値が反映されます。

（注）項目の左端に「+」または「-」の表示があるものは、編集エリアを隠したり表
示させたりすることができます。「+」が表示されている項目をダブルクリック
すると編集エリアが表示されます。「-」が表示されている項目をダブルクリッ
クすると編集エリアを隠すことができます。

表 10  アイコンによるフィールドの種類の表示

アイアイアイアイココココンンンン フィフィフィフィーーーールドルドルドルドのののの種類種類種類種類

field

exposedfield

eventIn

eventOut
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■■■■ Wizard タブタブタブタブ
Attribute ウィンドウよりも簡単にオブジェクトの属性を編集できる Object
Customize Wizardという機能も用意されています。選択しているオブジェク
トがWizardに対応している場合、Attribute ウィンドウに Wizardタブが表示
され、わかりやすい GUIによって属性の編集をすることができます。Wizard
ライブラリにあらかじめ用意されているライブラリオブジェクトは Wizard
に対応していますので、このオブジェクトを 3D Viewウィンドウにドラッグ
＆ドロップすると、図 15 に示す Wizardタブが表示されます。スライダー
バーなどを操作して、好みに合わせてオブジェクトをカスタマイズすること
ができます。

（注 1） Attribute ウィンドウでの変更は Wizardには反映されません。
（注 2） Object Customize Wizardによる属性の編集は Undoすることができません。

図 15  Object Customize Wizard
29



第 4章  Attributeウィンドウ
■■■■ PROTO内のノード編集内のノード編集内のノード編集内のノード編集
PROTO 内のノードが選択された場合、Attribute ウィンドウには eventIn、
eventOutを含むすべてのフィールドが表示されます。また、これらのフィー
ルドは ISを使ってのマッピングが可能です。（アンマップすることもできま
す。）

（注）PROTO 内のノード選択に関しては「第 11 章 Scene Graph ウィンドウ」（60
ページ）をご覧ください。

図 16  PROTO内のノード（TouchSensor）が選択された場合
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••••     ポッポッポッポッププププアッアッアッアッププププメニメニメニメニュュュューーーー

map with IS→ new
IS を使って新規にフィールドをマッピングします。このときに図 17
に示すダイアログボックスが現れ、フィールド名を設定することがで
きます。

新規に field または exposedFieldをマッピングする場合、マッピング
する前のフィールドの値が、デフォルト値となります。

図 17  フィールドを追加するためのダイアログ

（注）PROTO内の編集に関しては、オンラインの制限事項（Conductorをインストー
ルしたフォルダ内の doc¥restrict¥restrict-j.txt）をお読みください。

unmap from IS
マッピングされているフィールドを解除します。

■■■■ Script ノードに対する編集ノードに対する編集ノードに対する編集ノードに対する編集
Scriptノードが選択されている場合、ポップアップメニューの Remove field、
Add field によりフィールドの削除、追加を行うことができます。ただし、
classファイルがある場合は、ソースファイル（.javaファイル）が存在して
いる必要があります。また、URL が指定されていない場合は、フィールド
の追加、削除を行うことが可能です。
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図 18に示す Keyframe Editorウィンドウでは、VRML97で規定される Interpolator
ノードを編集することができます。Keyframe Editorを起動すると Keyframe 編集
モードになります。また、exposedField が変更されると自動的に対応する
Interpolatorノードが生成され、さらにルーティングも自動的に追加されます。
通常の編集モードに戻るには Keyframe Editorを終了させてください。

（注）Keyframe 編集モードではオブジェクトの編集は Interpolator に対する編集と
なり、オブジェクト自身の属性値は変更されません。オブジェクト自身の編集
を行うには Keyframe 編集モードを終了させて下さい。

図 18  Kyeframe Editorウィンドウ

（注）CoordinateInterpolator、NormalInterpolatorには対応しておりません。

■■■■ Keyframe Editor の起動および終了方法の起動および終了方法の起動および終了方法の起動および終了方法
Keyframe Editorは Mainウィンドウの を押すか、メニューから Edit→
Keyframeを選択します。

終了するには、Main ウィンドウの をもう一度押すか、メニューから
Edit → Keyframeを選択します。また、ウィンドウ右上の×ボタンをクリッ
クし、Keyframe Editorウィンドウを閉じて終了させることもできます。
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■■■■ Source の選択の選択の選択の選択
Sourceコンボボックスから Interpolatorを制御するためのフィールド（もし
くはイベント）を選択します。通常は、TimeSensorの fractionイベントとな
ります。ここに表示させるためには、あらかじめ TimeSensorなどに DEF名
をつけておく必要があります。

■■■■表示の拡大縮小、スクロール表示の拡大縮小、スクロール表示の拡大縮小、スクロール表示の拡大縮小、スクロール
（拡大ボタン）または （縮小ボタン）をクリックすることで、表示

エリアを拡大したり、縮小することができます。

または  （スクロールボタン）をクリックすることで、表示エリア
をスクロールさせることができます。

■■■■ Fraction の設定の設定の設定の設定

••••     From フィフィフィフィーーーールルルルドドドドとととと To フフフフィーィーィーィールルルルドドドド
Keyframe Editorが表示する範囲を指定します。これらの値は拡大、縮小ボ
タン、スクロールボタンを押した場合にも変化します。

••••     Current フフフフィーィーィーィールルルルドドドド
キーフレームを追加する場所を指定します。この値は、Fractionパネル（目
盛りがついている部分）をクリックした場合にも変化します。

■■■■表示のロック表示のロック表示のロック表示のロック
Lock チェックボックスをチェックすると、拡大、縮小ボタン、スクロール
ボタン、Fromフィールド、Toフィールドが固定されます。

■■■■アニメーションの動作確認アニメーションの動作確認アニメーションの動作確認アニメーションの動作確認
Keyframe Editor中の （Playボタン）を押すことで、現在の Sourceに関
連づけられた Interpolatorの動作を確認することができます。
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（注）ワールド全体の動作を確認するためには、Keyframe Editor を終了して、Main
ウィンドウの Playボタンを押してください。

■■■■ Loop チェックボックスチェックボックスチェックボックスチェックボックス
アニメーションをループさせるかどうかを指定します。Sourceコンボボック
スに TimeSensorが指定されている場合には、TimeSensorの loopフィールド
と連動します。

■■■■キーフレームの複数選択キーフレームの複数選択キーフレームの複数選択キーフレームの複数選択
同一の Interpolatorに属するキーフレームは、Shift キーを押しながらマウス
クリックすることで複数選択することができます。選択されたキーフレーム
は赤くなります。

■■■■ポップアップメニューポップアップメニューポップアップメニューポップアップメニュー
キーフレーム編集エリアでマウスの右ボタンをクリックすると図 19に示す
ポップアップメニューが表示されます。

図 19  Popupメニュー

••••     New Keyframe
現在の Fractionで指定された位置に新しいキーフレームを追加します。

••••     Cut
選択されたキーフレームをカットします。現在選択されている Interpolator
に対してのみ有効です。
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••••     Copy
選択されたキーフレームをコピーします。現在選択されている Interpolator
に対してのみ有効です。

••••     Paste
カットまたは、コピーした Keyframeをペーストします。

••••     Select all
選択された Interpolatorに含まれるすべてのキーフレームを選択します。

••••     Manipulate selection
選択された複数のキーフレームに対して、以下で説明するキーフレームの
操作を行います。

••••     Copy column to
現在の Fractionに含まれる（全ての Interpolatorの）キーフレームを他の
Fractionにコピーします。この操作は、複数のInterpolatorに対して有効です。

■■■■キーフレームの操作（スケーリング、スムージングキーフレームの操作（スケーリング、スムージングキーフレームの操作（スケーリング、スムージングキーフレームの操作（スケーリング、スムージング））））
選択されている複数のキーフレームに対して、スケーリングしたりスムージ
ングすることができます。複数のキーフレームを選択した状態で、マウスの
右ボタンを押して図 19 に示すポップアップメニューから「Manipulate
selection」を選んでください。

（注）スムージングは PositionInterpolatorに対してのみ有効です。

••••     スケスケスケスケーーーーリンリンリンリンググググ
図 20に示す Scale タブを選択すると、スケールページが表示されます。こ
こでは、キーフレームをスケーリングすることができます。

Scaling Factor：
スケーリングの値を指定します。

50% ：倍速
200%：半分の速度
100%：反転
Custom：数値（パーセント）で指定
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第 5章  Keyframe Editorウィンドウ
Scaling point：
スケーリングの中心点を指定します。

Left-hand keyframe：左端のキーフレーム
Center of selection：選択されているキーフレームの中心
Right-hand keyframe：右端のキーフレーム
Custom ：数値（目盛り）で指定

図 20  キーフレーム操作ダイアログ（Scaleタブ）
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••••     スムスムスムスムーーーージンジンジンジンググググ
図 21 に示す Smooth タブを選択すると、スムージングページが表示され
ます。ここでは、ベジェ曲線を使って中間のキーフレームを生成します。
これにより、よりスムーズな補間が可能になります。

# of smoothing keyframes:
既存のキーフレームに対して新規に挿入するキーフレームの数を指
定します。

Tension、Bias:
ベジエ曲線のパラメーターを指定します。通常は、-1.0から +1.0の
値を指定します。Tensionが 1.0の場合には、線形補間と同じになり
ます。

Loop first and last keyframe
最初と最後のキーフレームの値が一致している場合に使用します。

図 21  キーフレーム操作ダイアログ（Smoothタブ）
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図 22 に示す Library ウィンドウには用意された各種のライブラリが表示されま
す。これらは、ドラッグ＆ドロップによりワールドに追加することができます。
それぞれのライブラリページはタブをクリックして切り替えます。

図 22  Libraryウィンドウ
38



第 6章  Libraryウィンドウ
■■■■ドラッグ＆ドロップ操作ドラッグ＆ドロップ操作ドラッグ＆ドロップ操作ドラッグ＆ドロップ操作

••••     Texture
図 23に示すように、2D/3D Viewウィンドウ上のオブジェクトに対してド
ラッグ＆ドロップすることでテクスチャを貼り付けることができます。

図 23  ドラッグ＆ドロップによるテクスチャの貼り付け

••••     Sound、、、、Script、、、、Proto、、、、Wizard
2D/3D Viewウィンドウにドラッグ＆ドロップして使います。

（注）PROTO定義部もしくは Wizard定義部に、PROTOライブラリや Wizardライ
ブラリをドラッグ＆ドロップすることはできません。

••••     Avatar
Multi Userウィンドウ、2D/3D Viewウィンドウにドラッグ＆ドロップして
使います。

（注）Avatar ページはマルチユーザーワールドを編集中のみ表示されます。詳しくは
「第 8章  Multi User ウィンドウ」（44 ページ）をご覧ください。

■■■■関連アプリケーションの起動関連アプリケーションの起動関連アプリケーションの起動関連アプリケーションの起動
アイコンをダブルクリックすることにより、関連づけられたアプリケーショ
ンを起動し、アイコンに対応するファイルの内容をプレビューできます。
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■■■■ Script ライブラリのヘルプ表示ライブラリのヘルプ表示ライブラリのヘルプ表示ライブラリのヘルプ表示
Scriptライブラリでは、アイコンを選択し、F1キーを押すことにより各アイ
コンを解説するヘルプを表示することができます。ヘルプは、HTML ブラウ
ザーに表示されます。

（注 1） この機能を利用するためには、Netscape Navigator3.0以降または、Microsoft
Internet Explorer 3.0 以降が必要です。

（注 2） Netscape Navigatorまたは、Microsoft Internet Explorerを起動していない状
態でヘルプメニュー、もしくは F1 キーを選択した場合には、ブラウザを起
動するだけで、対象となるページにアクセスしません。Help を表示するに
は、Helpメニュー、もしくは F1キーを再度選択し直してください。

■■■■ライブラリフォルダーの変更ライブラリフォルダーの変更ライブラリフォルダーの変更ライブラリフォルダーの変更
Livrarウィンドウ内でマウスの右ボタンをクリックすると、現在表示中のラ
イブラリが参照しているフォルダーを変更するためのポップアップメ
ニュー（Set directory for this library.）が表示され、選択すると図 24 に示す
フォルダー選択ダイアログボックスが開きます。

フォルダーを変更するためには、希望するフォルダーをクリックして開いた
状態にしておき、OKボタンを押します。

図 24  フォルダ選択ダイアログボックス
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■■■■アイコンのカスタマイズアイコンのカスタマイズアイコンのカスタマイズアイコンのカスタマイズ
Libraryウィンドウでのアイコンは以下のルールにしたがって表示されます。

1. Textureライブラリでは、テクスチャファイルの画像がそのままアイコン
として表示されます。

2. それ以外のライブラリでは、ライブラリファイルと同じディレクトリにあ
る同名で拡張子が .bmpのファイルをアイコンとして使用します。もし、
これが存在しない場合には、ライブラリディレクトリにある _default.bmp
が使われます。このファイル名の先頭には _（アンダーバー）が付きます
ので注意してください。

3. もし、_default.bmpも存在しない場合には、Conductorのアイコンが使用さ
れます。

4. 各ライブラリファイルに対応した bmpファイルを用意することで、アイ
コンをカスタマイズすることができます。

（注）アイコンファイルの大きさは32ドット×32ドット以上でなければなりません。

■■■■各ライブラリでの対応フォーマット各ライブラリでの対応フォーマット各ライブラリでの対応フォーマット各ライブラリでの対応フォーマット

••••     Texture
bmp、gif、jpegが使用できます。

••••     Sound
wav、modが使用できます。

（注）modを使うためには、DirectX3.0以降がインストールされている必要がありま
す。

••••     Script
Scriptノードを記述した VRML ファイルと、classファイルが必要です。

••••     Proto
PROTOが記述された VRML ファイルです。VRML ファイルには、PROTO
定義と PROTOインスタンスが記述されている必要があります。

（注）PROTOインスタンスは、他のノードで囲まれていてはいけません。

••••     Wizard
Object Customize Wizardに対応し VRML ファイルです。
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Wizard に対応したオブジェクトを作成する方法は、「第 15 章 Object
Customize Wizardの作成方法」（85 ページ）をご覧ください。

••••     Avatar
Avatarを記述した VRML ファイルです。

■■■■ライブラリへの追加ライブラリへの追加ライブラリへの追加ライブラリへの追加
ライブラリフォルダーにファイルを追加もしくは削除することで、ライブラ
リオブジェクトを追加もしくは削除することができます。Textureライブラ
リへ追加するときは、対応フォーマットの画像ファイルを Library ウィンド
ウにドラッグ＆ドロップします。
Proto ライブラリへ Proto を追加するときは、Scene Graphウィンドウのスコープ
を追加したい Proto に切り替え、ポップアップメニューからRegister to the Libray
を選択します。
ライブラリオブジェクトの追加または削除の際、アイコンの表示は自動的に更
新されます。
42



第 7章  Messageウィンドウ

43

第 7章  Messageウィンドウ

図 25に示す Messageウィンドウでは実行時に発生した警告メッセージ、Javaコ
ンパイラからのエラーメッセージなどを表示します。

図 25  Messageウィンドウ

■■■■ Warning メッセージメッセージメッセージメッセージ
Warningタブを選択することで、警告メッセージを見ることができます。

■■■■ Java コンパイラからのメッセージコンパイラからのメッセージコンパイラからのメッセージコンパイラからのメッセージ
コンパイル時のエラーメッセージなどが出力されます。コンパイルエラーが
発生した場合には、Messageウィンドウのエラー行をダブルクリックするこ
とで、Text Editorウィンドウのエラーのある場所にジャンプすることができ
ます。
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Multi Userウィンドウでは、マルチユーザーワールドの作成時に、マルチユーザー
サーバー（Community Place Bureau （以下 Bureau））の設定と、そのワールドで使
用可能となるアバターの指定を行います。Bureauの使い方については、Bureau の
マニュアルをご覧ください。

■■■■マルチユーザーワールドの作成マルチユーザーワールドの作成マルチユーザーワールドの作成マルチユーザーワールドの作成
シングルユーザーワールドを読み込んだ場合は、Multi Userウィンドウには
「Create Multi User world」と表示されたボタンが表示されます。現在編集中
のコンテンツをマルチユーザーワールドにするためにはこのボタンを押し
てください。その結果、Sony_WorldInfoノードが生成されマルチユーザー
ワールドになります。Scene Graphウィンドウで、Sony_WorldInfoノードを
生成した場合もマルチユーザーワールドにすることができます。
その後、以下のようにマルチユーザーサーバーの設定と、そのワールドで使
用可能となるアバターの指定を行います。
シングルユーザーワールドに切り替えるためには、Scene Graph ウィンドウ
で Sony_WorldInfoノードを削除してください。

■■■■マルチユーザーサーバーの設定マルチユーザーサーバーの設定マルチユーザーサーバーの設定マルチユーザーサーバーの設定
Serverタブをクリックすると、図 26に示す Serverページが表示されます。
ここでは、このコンテンツが接続するマルチユーザーサーバー（Bureau）の
ホスト名とポート番号を設定することができます。
このページでの設定は Sony_WorldInfoノードの cpBureauフィールドに反映
されます。
host 欄が空白の場合は、自動的に「localhost」が設定されます。作成したマ
ルチユーザーワールドのテストのために、Bureauとコンテンツをローカルマ
シンで起動する場合はこのままで動作します。
port 欄が空白の場合は、自動的に「5126」が設定されます。これは Bureauの
デフォルトのポート番号です。
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図 26  Serverタブが選択されている様子

■■■■使用アバターの指定使用アバターの指定使用アバターの指定使用アバターの指定
Avatarタブをクリックすることで図 27に示す Avatarページが表示されます。
Avatarページでは現在作成しているマルチユーザーワールドで、ユーザーが
使用できるアバターのリストを表示します。

図 27  Avatar タブを選択した様子
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••••     アバターのリストへの追加
使用できるアバターを追加したい場合は、Library ウィンドウのAvatarペー
ジから Multi User ウィンドウの Avatarページ（または 3D Viewウィンド
ウ）へ、アバターのアイコンをドラッグ＆ドロップします。Library ウィ
ンドウの Avatar ページはコンテンツがマルチユーザーワールドの時のみ
選択可能です。

図 28  Libraryウィンドウから Avatarウィンドウへアバターをドラッグ＆ドロップしているところ

••••     アバアバアバアバタタタター名ー名ー名ー名のののの変更変更変更変更
Multi User ウィンドウの Avatarページでアバターアイコンを選択すると、
保存時のアバターファイルの相対 URLがウィンドウ下のステイタスバー
に表示されます。相対 URLが同じアバターは追加することができません。
この場合はアイコンの名前を変更して保存時のアバターのファイル名を
変更してください。（ただし日本語は使用できません。）
例えば、ライブラリーの同じアバターを基に編集を加えてオリジナルのア
バターを複数作成する場合や、読み込んだマルチユーザーワールドに含ま
れるアバターと、ライブラリーから追加しようとしたアバターが同じURL
となる場合には名前の変更が必要です。
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••••     アバターのリストからの削除
使用できるアバターのリストから、あるアバターを削除するには Multi
User ウィンドウの Avatarページで、削除したいアバターを選択し、Delete
キーを押すか、マウスの右ボタンをクリックして、ポップアップメニュー
から「Delete」を選びます。

図 29  アバターの削除

••••     アバターの編集
使用できるアバターのリストに含まれるあるアバターを、確認および編集
するには Multi User ウィンドウの Avatarページで、編集したいアバターを
選択し、マウスの右ボタンをクリックして、ポップアップメニューから
「Preview」を選びます（または改行キーを押すか、マウスの左ボタンをク
リック）。
すると、アイコンに赤い枠が表示され、3DViewにアバターが表示されま
す。
Scene Graph にはアバターファイルが Inline ノードとして生成され、その
Inlineノードのスコープに入ることで、アバターの編集をすることができ
ます。
ただしアバターはワールドに含まれるオブジェクトではなく、編集のため
に一時的にワールドに追加されただけであることに注意してください。
ワールドの保存時にはアバターの Inlineノードはワールドから削除されま
す。
47



第 8章  Multi User ウィンドウ
アバターの編集を終了するには、Avatar ページでそのアバターを選択し、
再びポップアップメニューから「Preview」を選びます（または改行キー
を押すか、マウスの左ボタンをクリックします）。

図 30  アバターを表示する前（上図）と表示したところ（下図）
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第 8章  Multi User ウィンドウ
■■■■マルチユーザーワールドの動作確認マルチユーザーワールドの動作確認マルチユーザーワールドの動作確認マルチユーザーワールドの動作確認
作成したマルチユーザーワールドの動作確認をするには、まず Serverペー
ジで設定したホストとポートに従って Bureauを起動します。
その後編集中のコンテンツを保存して Playボタンを押すと、Conductorで
動作の確認ができます。
アバターの姿や動作を確認するには、複数の Browser（または Conductor）
を起動してそのコンテンツを読み込んでください。
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第 9章  Parallel Viewウィンドウ

図 31に示す Parallel Viewウィンドウでは、3つの Parallel View（平行投影の View）
を表示します。3つの Parallel Viewとは、上面図（Top View）、側面図（Side View）、
正面図（Front View）です。これらの View ではオブジェクトは常にワイヤーフ
レームモデルで表示されます。

図 31  Parallel Viewウィンドウ

■■■■視点位置と視線方向の表示視点位置と視線方向の表示視点位置と視線方向の表示視点位置と視線方向の表示
視点位置と方向は，左下隅の視点位置表示パネルに数値で表示されます。

このパネルをクリックすることにより、表 11に示すように表示を切り替え
ることが可能です。
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Parallel Viewでの視点位置、視線方向はワールド座標系で以下の表のように
なります。

■■■■ポップアップメニューポップアップメニューポップアップメニューポップアップメニュー
マウスの右ボタンをクリックすることにより表示されます。
ポップアップメニューは、以下のサブメニューで構成されます。

••••     Home Position コマコマコマコマンンンンドドドド
視点位置、視線方向、ズーム率をデフォルト値に戻します。3D Viewの場
合と異なり、移動途中の様子は表示されません。Home Positionの値は、固
定で以下の表のようになります。

表 11  視点位置表示パネルに表示される数値

表表表表示示示示内容内容内容内容 変数変数変数変数 表表表表示示示示例例例例

ワールド座標系での視点位置 （P）

現在のズーム率の割合 （S）

ワールド座標系での視線方向 （V）

表 12  Parallel Viewの視点位置と視線方向

View のののの種種種種類類類類 視視視視点点点点位置位置位置位置 視線視線視線視線方方方方向向向向

Top View X-Z 平面と平行な面上 -Y 軸固定

Side View Y-Z 平面と平行な面上 -X 軸固定

Front View X-Y 平面と平行な面上 -Z軸固定

表 13  Home Positionの値

viewのののの種種種種類類類類 視点視点視点視点位位位位置置置置 視視視視線線線線方向方向方向方向 ズズズズーーーーム率ム率ム率ム率

Top View X = 0、Z = 0 -Y軸固定 1.0

Side View Y = 0、Z = 0 -X軸固定 1.0

Front View X = 0、Y = 0 -Z軸固定 1.0
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Mouse Mode、View Point に関する説明は 22 ページを参照してください。

■■■■オブジェクトの生成オブジェクトの生成オブジェクトの生成オブジェクトの生成
3D Viewでのオブジェクトの生成と同様に Parallel View内でもオブジェクト
を生成することができます。Parallel Viewでは、生成する際にマウスを押し
た地点の真下に生成されます。
また、生成されるオブジェクトのワールド座標は、各視線方向のワールド座
標が０となる位置に生成されます。

例えば TopViewでオブジェクトの生成を行った場合、オブジェクトはマウス
ポインターの位置に対応するワールド座標の位置（X,0,Z）に生成されます。

■■■■ナビゲーションの方法ナビゲーションの方法ナビゲーションの方法ナビゲーションの方法
基本的には 3D Viewでのナビゲーションと同じです。
ただし、キーボードの矢印キーは使用できません。

各 Parallel Viewでは、各々の視線方向に垂直な面上の移動のみ可能です。平
行投影では視線方向で移動しても表示は変わりません。
以下の表に Parallel Viewでのナビゲーションの方法を示します。

Parallel Viewウィンドウ内で Ctrlキーを押しながらクリックをすると、視点
をその位置まで移動させることができます。

表 14  ナビゲーションの方法

動動動動きききき 修修修修飾飾飾飾キキキキーーーー ドドドドラッラッラッラッググググ方向方向方向方向
視視視視点点点点位位位位置移置移置移置移動動動動方向方向方向方向

ズズズズーーーーム率ム率ム率ム率

Top Side Front

下方移動 下 +Z -Y -Y

上方移動 上 -Z +Y +Y

左方移動 左 -X -Z -X

右方移動 右 +X +Z +X

ズームイン Shift 上 大

ズームアウト Shift 下 小
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（注）ズーム率は初期値が１で、初期値に対する割合として増減します。最小で 0.01
倍、最大で 16倍に制限されています。

■■■■オブジェクトの移動オブジェクトの移動オブジェクトの移動オブジェクトの移動
操作方法は、3D Viewと同じで、視線に垂直な面内でオブジェクトを移動す
ることができます。例えば、TopViewでのオブジェクトの移動は X-Z平面内
で行われ、Y 軸方向の位置は変化しません。

■■■■オブジェクトの回転オブジェクトの回転オブジェクトの回転オブジェクトの回転
操作方法は、3D Viewと同じですが、回転の方法に制限があります。Parallel
View でのオブジェクトの回転軸は、そのオブジェクトのローカル座標原点
を通り、その Viewでの視線方向と平行な方向を持つ軸になります。

■■■■オブジェクトのスケーリングオブジェクトのスケーリングオブジェクトのスケーリングオブジェクトのスケーリング
操作方法は、3D Viewと同じです。ただし、スケール中心は 3D Viewのよう
にオブジェクトを囲むバウンディングボックスの中心でなく、オブジェクト
のローカル座標の原点となります。このローカル原点の中心に向かってマウ
スをドラッグさせると縮小し、遠ざけると拡大します。
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図 32に示す Routeウィンドウでは、カレントスコープ内で発生するイベントの
ルーティングの表示および追加・削除を行います。カレントスコープについて
は、「第 11章 Scene Graphウィンドウ」（60 ページ）をご覧ください。

ウィンドウ内の左下のボタンをクリックすることで、以下の 3つの表示に切り替
えることができます。

  ： リスト表示

  ： リストとビジュアルの混合表示

  ： ビジュアル表示

■■■■リスト表示での操作リスト表示での操作リスト表示での操作リスト表示での操作

図 32  Routeウィンドウ
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Route from
NodeName :イベントを出力するノードの名前
eventOut :イベントアウト名（eventOut型のフィールド名）

Route to
NodeName :イベントを受信するノードの名前
eventIn :イベントイン名（eventIn型のフィールド名）

（注）ノードにはあらかじめノード名が定義されている必要があります。

••••     ルールールールートトトトの追の追の追の追加加加加
ルートの追加は以下のように行います。

1. イベントを出力するノードのノード名をNodeNameリストから選択す
る。

2. eventOutをリストから選択する。
3. イベントを受けるノード名を NodeNameリストから選択する。
4. eventInをリストから選択する。

（注）リストに表示される eventInは、eventOutの型と同じ型のものだけです。

5. Addボタンを押す。
ルーティングが追加され、ルーティングリストに表示されます。

••••     ルールールールートトトトの削の削の削の削除除除除
削除したいルートをリストボックスから選択し、Deleteボタンを押しま
す。
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■■■■ビジュアル表示での操作ビジュアル表示での操作ビジュアル表示での操作ビジュアル表示での操作
ビジュアル表示モードでは、アイコンを使ってルートの表示が行われます。
アイコンはノード単位で表示され、ルートの追加、削除に応じて自動的に再
レイアウトされます。また、DEF名がついていてかつルートを持っていない
ノードは、ウィンドウ内の下部に表示されます。

図 33  Routeウィンドウをビジュアル表示にした場合

••••     ルールールールートトトトの選の選の選の選択択択択
ノードを結んでいる線をクリックすると、そのルートが選択され、Route
ウィンドウの下部にあるステータスバーにルートの内容が表示されます。
複数のルートがある場合にはポップアップで表示されます。いずれかの
ルートをクリックするのことで選択できます。

図 34  複数のルートがある場合
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••••     ルールールールートトトトの追の追の追の追加加加加
Routeウィンドウ中のアイコンを他のアイコンにドラッグ＆ドロップする
か、Scene Graphウィンドウとの間でドラッグ＆ドロップします。Scene
Graphウィンドウのノードには DEF 名がついている必要はありません。
（自動的に DEF名が付きます）

詳しい方法については、チュートリアルをご覧ください。

••••     ルールールールートトトトの削の削の削の削除除除除
ルートを選択しておき、右クリックでポップアップメニューを表示させ、
削除したいルートを選択します。

図 35  ルートを削除する時のポップアップメニュー

••••     アイアイアイアイココココン間ン間ン間ン間隔隔隔隔の調の調の調の調整整整整
左下①のスライダーバーにより、アイコン間隔を広げたり、狭めたりする
ことができます。ルートの状況が複雑な場合、見やすいように調整します。

図 36  アイコン間隔を広げている様子
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■■■■ DEF名の自動生成と変更名の自動生成と変更名の自動生成と変更名の自動生成と変更
DEF名のついていないノードを Scene Graphウィンドウから Routeウィンド
ウへドロップすると、DEF 名が自動的に付加され、DEF 名を変更できる状
態になります。DEF 名はノードの種類（例えば、TouchSensorの場合は
TouchSensor_00）をもとに生成されます。

図 37  DEF名が自動生成された直後

■■■■ポップアップメニューポップアップメニューポップアップメニューポップアップメニュー
マウスの右ボタンでアイコンをクリックした場合：

そのアイコンのルーティング状態を確認することができます。

マウスの右ボタンでアイコン以外の部分をクリックした場合：

••••     2D Layout
ルート表示を２次元でレイアウトします。

••••     1D Topological layout
ルート表示を１次元（接続の順番）でレイアウトします。
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••••     1D Alphabetical layout
ルーティング表示を１次元（アルファベット順）でレイアウトします。

••••     Animate changes
この項目がチェックされていると、再レイアウトの様子をアニメーション
で表示します。

••••     Fade descendants
Scene Graphウィンドウ上で現在選択されているノードに関連するルート
を破線で表示します。これにより、ノードを削除した場合にどのルートが
削除されるのかを知ることができます。

図 38  マウスの右ボタンでアイコン以外の部分を
クリックした 時のポップアップメニュー
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図 39に示す Scene Graphウィンドウは、カレントスコープのワールドのツリー構
造を VRML97 のノード単位で表示します。また、シーングラフ上の任意のノー
ドを選択したり、ドラッグ＆ドロップによりノードを移動させたりすることも可
能です。

ノードに DEF名がついている場合には、[] で囲まれた DEF名がノード名の後ろ
に表示されます。また、Inlineノードについては、URL 情報が <>の中に表示さ
れます。

図 39  Scene Graphウィンドウ

■■■■ファイルスコープの切り替えファイルスコープの切り替えファイルスコープの切り替えファイルスコープの切り替え
VRML ファイルに Inlineノードが含まれる場合、それぞれに１つのスコープ
が与えられます。各ノードの編集は現在のスコープに対してのみ可能です。
画面最上部のコンボボックスにより、編集対象となる「カレントスコープ」
を切り替えることができます。
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図 40  スコープ切り替えコンボボックス

■■■■ PROTOスコープの切り替えスコープの切り替えスコープの切り替えスコープの切り替え
現在選択されているファイル内に PROTOが含まれる場合、PROTOのスコー
プを切り替えるタブが表示されます。

図 41  PROTOのスコープを切り替えるタグ
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■■■■ノードの選択ノードの選択ノードの選択ノードの選択
選択したいノードをクリックします。選択されたノードは、Attributeウィン
ドウで属性を変更できるようになります。ノードをダブルクリックすると、
ノードが選択されると同時に、Attributeウィンドウが表示されます。

■■■■へルプの表示へルプの表示へルプの表示へルプの表示
F1キーを押すと HTML ブラウザーに VRML97 の解説ページが表示されま
す。オブジェクトが選択されていれば、そのノードの説明が表示されます。

（注）この機能は、Netscape Navigator 3.0 以降または、Microsoft Internet Explorer
3.0 以降にのみ対応しております。Netscape Navigator または、Microsoft
Internet Explorerを起動してから F1キーを押してください。

■■■■ポップアップメニューポップアップメニューポップアップメニューポップアップメニュー 

図 42  Scene Graphウィンドウのポップアップメニュー
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••••     Expand All
現在選択されているノードより下層にあるツリーを全て開きます。

••••     Find Node
図 43に示すダイアログボックスが表示されます。
ノードの DEF名で検索するには By Name タブを，ノードタイプで検索す
るには By Typeタブをクリックすることで、それぞれのページを表示させ
ます。
検索したい文字列はコンボボックスにより選ぶことができます。

図 43  Find Node ダイアログボックス

Direction
Backward: 逆方向へ検索します。
Forward: 順方向へ検索します。

Origin
From cursor: カーソルのある位置から検索します。
Entire scope: ファイルの頭から検索します。

••••     Search Again
Find Nodeで設定した条件の下で再検索します。

••••     Add Node
VRML97 で規定されるノードを追加します。ノードはカテゴリー毎にサ
ブメニューに分かれています。
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図 44  Add Node を選択している様子

Add USE
現在のスコープ内で有効な DEF 名が表示され、選択すると USE を
使ってノードを生成します。

Add ProtoInstance
現在のスコープ内で有効な PROTOがサブメニューに表示され、選択
するとインスタンスを追加します。

••••     Insert Grouping Node
選択されているノードに対する親ノードとして、グルーピングノードを追
加します。

••••     Edit Node
選択されているノードのカット、コピー、ペースト、削除を行います。
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••••     Go to Definition
PROTOインスタンスあるいは、Inlineノードが選択されている場合、定義
スコープに切り替えます。

••••     Point of Interest
選択されているオブジェクトが正面に表示されるようにします。グルーピ
ングノード、ジオメトリノード、ライトノード、Viewpoint に対してのみ
有効です。

••••     Set Node Name
選択されているノードの DEF名を設定するためのダイアログボックスを
表示します。

図 45  DEF名設定用ダイアログ

••••     Create PROTO
選択されているノードをもとに PROTOを作成します。選択されている
ノードは PROTOインスタンスに置き換わります。

（注 1） このメニューを選択すると Undoできなくなります。
（注 2） CreatePROTOによりPROTOを生成すると、自動的に大文字表記によるDEF

名も付けられます。

••••     Register to the Library
選択されているノードが参照するファイルをライブラリーに登録します。
登録が可能なファイルの候補がサブメニューに表示され、選択するとファ
イルのフォーマットに対応するライブラリーに登録されます。
PROTOのスコープが選択されている場合は、PROTO名がサブメニューに
表示され、選択すると編集中の PROTOが Protoライブリに登録されます。

同名のファイルが既に登録されている場合は、上書きを確認するダイアロ
グボックスが表示されます。上書きしない場合は、続いて表示されるダイ
アログボックスで登録先のフォルダーを変更して下さい。
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（注）ファイルのフォーマットについては、Library ウィンドウの章を参照して下さ
い。

••••     Open .wrl
選択されているファイルスコープの VRML ファイルを Text Editorに表示
します。

（注）編集中の VRML ファイルの内容を表示させるには、先に保存する必要があり
ます。

••••     Open .java
選択されている Scriptノードに対応する Javaファイルを Text Editorに表
示します。Scriptノードが選択されており、かつソースファイルが存在す
る場合にのみ、このメニューを使うことができます。
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VRML97 のスクリプトノードに対応した Javaプログラムのテンプレート（ひな
型）を生成します。

図 46  Script Expertダイアログボックス

■■■■ Script の生成法の生成法の生成法の生成法
以下の 4つのフィールドに入力し、最後に OKボタンを押します。

DEF: 
VRML から Javaプログラムを呼び出せるようにするために、スクリ
プトノードに名前をつけます。

Class Name:
Javaのクラス名を指定します。
Javaの仕様によりクラス名は、そのままファイル名になります。

field type: 
eventInまたは eventOutに対するフィールドの種類を指定します。
VRML のフィールドの種類がすべてリストされますので、その中か
ら選択してください。

field name: 
eventInまたは eventOutに対するフィールドの名前を指定します。
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これにより、Javaプログラムのテンプレート（ひな型）が作成され、Text
Editorで表示されます。
また、同時に Scene Graphウィンドウに Scriptノードも追加されます。

（注）Script Expertウィンドウでは複数の eventIn、eventOutを指定することはでき
ません。複数の eventIn、eventOutをもつには、一度 Script Expertで Scriptを
生成しておいて、後から、Attribute ウィンドウで追加してください。event の
追加を行うには、Scene Graph ウィンドウで Script ノードを選択しておき、
Attributeウィンドウのポップアップメニューから、add fieldを選択します。
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図 47に示す Text Editorウィンドウは、VRML ファイルや Javaファイルを編集す
るためのテキストエディターです。スクリプトを編集している場合には、Attribute
ウィンドウと連動して自動的に必要なハンドラが追加、削除されます。

図 47  Text Editorウィンドウ

■■■■ Text Editor によるファイルの開き方によるファイルの開き方によるファイルの開き方によるファイルの開き方
Text Editorは Scene Graphウィンドウのポップアップメニュー（Open .wrl,
Open .java）を選択するか、または Text Editorウィンドウ内にファイルをド
ラッグ＆ドロップすることでファイルを開くことができます。

■■■■ Text Editor の終了方法の終了方法の終了方法の終了方法
Text Editorウィンドウ右上の×ボタンをクリックすることで、終了させるこ
とができます。ファイルが変更されている場合には、保存を促すダイアログ
が表示されます。
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（注）Scene Graph ウィンドウのポップアップメニューから Open .wrl を選択し、
VRML ファイルを編集した場合は、ファイルを再読み込みするまで反映されま
せん。

■■■■ポップアップメニューポップアップメニューポップアップメニューポップアップメニュー

••••     Compile
編集中のファイルをコンパイルします。コンパイルが正常に終了したとき
は、Messageウィンドウに「Done」と表示されます。エラーが発生したと
きは、エラーメッセージが表示されます。

••••     Find
編集中のファイルに含まれる文字列を検索するためのダイアログボック
スが表示されます。Replace、Replace All ボタンを押すことで、置換、全
て置換を行うことも可能です。

図 48  Find Text ダイアログボックス

Text to Find:検索する文字列を入力します。
Replace to:置換する文字列を入力します。

Option
Case Sensitive:チェックされている場合は大文字、小文字を区別しま

す。
Entire Word: 完全に一致する文字列を検索します。
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Direction
Backward: 逆方向へ検索します。
Forward: 順方向へ検索します。

Origin
From cursor: カーソルのある位置から検索します。
Entire scope: ファイルの頭から検索します。

••••     Find Next
Findで設定した条件の下で再検索します。

••••     Go to Line Number
指定した行へ移動します。

••••     Select node
VRML ファイル中の DEF名を選択するとこのメニューが利用可能になり
ます。Scene Graph ウィンドウのカレントスコープが一致する場合に、DEF
名がつけられたノードを選択状態にすることができます。

••••     Cut、、、、Copy、、、、Paste
テキストエリアのカット、コピー、ペーストを行います。

••••     Close File
編集中のファイルを閉じます。

••••     Save File
編集中のファイルを保存します。

••••     Read Only
編集中のファイルの Read Only属性を変更します。
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Texture Mappingウィンドウでは、IndexedFaceSetノードに対するテクスチャマッ
ピングの指定および色の設定を行います。

（注）このウィンドウは IndexedFaceSetノードを選択している場合にのみ使うこと
ができます。

以下で各ページについて説明します。

■■■■ Color ページページページページ
Colorタブをクリックすることにより図 49に示す Colorページが表示されま
す。このページは、デフォルトでない Color Modeが選択された時にのみ表
示されます。
Colorページには以下の情報が表示されます。

図 49  Colorページ

① Face

Color Mode が「Use Appearance」以外に設定されている時、テクスチャが
無い状態の現在の IndexedFaceSetが表示されます。
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② Color toolbar

表 15に示すこれらのツールは Face内でクリック、またはドラッグして使
用します。

③ Fill all faces

選択されている IndexedFaceSetのすべての面を、現在の色で塗りつぶしま
す。

④ Current color

現在の色が表示されます。クリックすると色選択のダイアログボックスが
表示されます。スポイトツールを使用することもできます。

⑤ Recently used colors

最近使った色が表示されます。クリックすることで再び使うことができま
す。

⑥ Change Color Mode

Change Color Mode ダイアログボックスを開きます。

⑦ Status bar

Color modeやツールによって異なったメッセージが表示されます。ブラシ
ツールを使っているとき、以下の表 16に示すメッセージが表示されます。

表 15  Color toolbar

ボボボボタンタンタンタン 機機機機能能能能

 ブラシツール 面または頂点を現在の色でペイントします。

 スポイトツール
マウス位置に最も近い頂点の色を、読み取って
現在の色として設定します。
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（注）1 color per vertex、1 color per vertex（indexed）は頂点毎に色を設定するため、隣
接する面にも影響があります。3D Viewウィンドウでは正しい色が表示されま
せん。

表 16  Color modeのメッセージ

カラカラカラカラーーーーモーモーモーモードドドド メメメメッセッセッセッセーーーージジジジ 意意意意味味味味

1 color per face 
（indexed）

Click on the face to use this 
color.

この色を使用するには面
の上でクリックしてくだ
さい。

1 color per face
Click on the face to use this 
color.

この色を使用するには面
の上でクリックしてくだ
さい。

1 color per vertex
Click near a vertex to 
change its color. 

頂点の近くでクリックす
ると、その頂点の色が変わ
ります。

1 color per vertex 
（indexed）

Click near a vertex to 
change its color.

頂点の近くでクリックす
ると、その頂点の色が変わ
ります。
74



第 14章  Texture Mappingウィンドウ
■■■■ Texture Coordinate ページページページページ
Texture Coordinatesタブをクリックすることにより図 50 に示す Texture
Coordinatesページが表示されます。このページには、デフォルトでない
Texture Modeが選択された時にのみ表示されます。
Texture Coordinateページには以下の情報が表示されます。

図 50  Texture Coordinateページと 3D Viewウィンドウ

① Texture sample

3D/2D View ウィンドウで選択された IndexedFaceSet のテクスチャとテク
スチャ座標が表示されます。選択されている IndexedFaceSet は、3D/2D
Viewウィンドウで赤枠で囲まれて表示されす。テクスチャが無いか、ロー
ドできなかった場合、座標をセットするためにデフォルトのテクスチャが
表示されます。

② Texture coordinate tools

表 17に示すテクスチャ座標を操作するするツールがあります。これらの
ツールは Texture sample内でマウスをドラッグして操作します。
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③ Texture sample tools

表 18 に示すこれらのツールはテクスチャ座標には何の効果も与えませ
ん。Texture sampleで、テクスチャ座標の表示を操作する際に使います。

④ Default mapping

テクスチャ座標を囲む矩形が [0, 0] - [1, 1]内に合うようにテクスチャ座標
を設定します。

⑤ Zoom to fit

テクスチャ座標全体が Texture sample内におさまるように、Texture sample
toolsのズームとパンの設定を調整します。

表 17  Texture coordinate tools

ボボボボタンタンタンタン 機能機能機能機能

 Point-by-point テクスチャ座標の頂点を個別に移動します。

 Transform テクスチャ座標を移動します。

 Rotation
白丸を中心にテクスチャ座標を回転します。白丸は
ドラッグで移動させることができます。

 Scale
テクスチャ座標を x、y 方向に拡大したり縮小し
ます。

 Skew テクスチャ座標を x、y方向にゆがめます。

表 18  Texture sample tools

ボボボボタタタタンンンン 機機機機能能能能

 Zoom
クリックした点が中心になるように、マウスの左ボタンで
ズームイン、右ボタンでズームアウトします。

 Pan
マウスをドラッグすることにより texture sampleを移動し
ます。
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⑥ Projection

Projectionダイアログボックスを開きます。

⑦ Change Texture Mode

Change Texture Mode ダイアログボックスを開きます。

⑧ Mesh Type

 表 19に示すように Mesh の表示範囲を指定します。

⑨ Mesh Color

Mesh Typeが Show neighbor facesもしくは、Show all facesである場合、選
択したMesh 以外の Mesh の色を指定します。

⑩ Status bar

現在のツールに関するメッセージを表示します。

表 19  Mesh Type

種類種類種類種類 表示表示表示表示

Show selected face 選択した面のみ表示します。
Show neighbor faces 選択した面と隣接する面を表示します。
Show all faces すべての面を表示します。
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■■■■ Change Color Mode ダイアログボックスダイアログボックスダイアログボックスダイアログボックス
図 51 に示す Change Color Modeダイアログでは IndexedFaceSetの color、
colorIndex、colorPerVertex フィールドの設定を行います。デフォルトのモー
ドは「Use Appearance」です。カラーモードはラジオボタンで選択できます。

図 51  Change color modeダイアログボックス

表 20 に示すカラーモード対応表は、各カラーモードと IndexedFaceSetの
フィールドの関係を示しています。
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「Notes」の欄には、現在選択されているカラーモードの簡単な説明が表示さ
れます。各カラーモードについての説明は表 21のとおりです。

表 20  カラーモード

カカカカラーラーラーラーモモモモードードードード
colorPerVertex
フフフフィィィィールールールールドドドド

color
フフフフィーィーィーィールルルルドドドド

colorIndex
フフフフィーィーィーィールルルルドドドド

Use Appearance -- 不使用 不使用

1 color per face （indexed） FALSE 使用 使用
1 color per face FALSE 使用 不使用
1 color per vertex TRUE 使用 不使用

1 color per vertex （indexed） TRUE 使用 使用
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（注）Change Color Mode にて 1 color per vertex あるいは、1 color per vertex
（indexed）が選択されている場合は、3D Viewウィンドウでは正しい色が表示
されません。

表 21  カラーモードの説明

カラカラカラカラーーーーモーモーモーモードドドド 表表表表示内示内示内示内容容容容 意味意味意味意味

Use Appearance
This IndexedFaceSet uses 
the color information given 
in its Appearance node.

Appearanceノードで与えられ
た色情報を使用します。

1 color per face 
（indexed）

Each face has a solid color, 
which is chosen from a 
palette of colors.  This will 
optimize the file size if the 
number of different face 
colors is small （but 
greater than one）.

各面はカラーパレットから
選ばれた単色で描画されま
す。異なる面の色数が少ない
（ただし 1 以上）場合は、1
color per faceモードに比べ、
こちらの方がファイルサイ
ズは小さくなります。

1 color per face

Each face has a solid color.  
This will optimize the file 
size if the number of 
different face colors is 
large.

各面は単色で描画されます。
異なる面の色数が多い場合
は、1 color per face （indexed）
モードに比べ、こちらの方が
ファイルサイズは小さくな
ります。

1 color per vertex

Each vertex has its own 
color.  Vertices shared by 
several faces must have the 
same color.

各頂点ごとに色を割り当て
ます。複数の面によって共有
されている頂点は同じ色を
持ちます。

1 color per vertex 
（indexed）

Each vertex has its own 
color.  Vertices shared by 
several faces may have 
different colors. 

各頂点ごとに色を割り当て
ます。複数の面によって共有
されている頂点の色が異な
る場合があります。
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以下に示すカラーモードの変更を行った場合、現在の色の情報は失われま
す。

1 color per face （indexed） → Use Appearance, 1 color per vertex
1 color per face → Use Appearance, 1 color per vertex
1 color per vertex → Use Appearance, 1 color per face （indexed）, 1 

color per face
1 color per vertex （indexed）→ すべてのカラーモード

（注）OKボタンをクリックしなければシーンは変化しません。

■■■■ Change Texture Mode ダイアログボックスダイアログボックスダイアログボックスダイアログボックス
図 52に示す Change Texture Modeダイアログボックスは IndexedFaceSetの
texCoord、 texCoordIndex フィールドの設定を行います。デフォルトのモード
は「Default mapping」です。テクスチャモードはラジオボタンで選択できます。

図 52  Change texture modeダイアログボックス
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表 22に各テクスチャモードと IndexedFaceSetのフィールドとの関係について
示しています。

 

「Notes」の欄には、現在選択されているテクスチャモードの簡単な説明が出
ます。各テクスチャモードについての説明は以下のとおりです。

表 22  テクスチャモードとフィールドの関係

テクテクテクテクススススチャチャチャチャモモモモードードードード
coord

フフフフィーィーィーィールルルルドドドド
coordIndex
フフフフィィィィールールールールドドドド

Default mapping 不使用 不使用
1 coordinate per vertex 使用 不使用
1 coordinate per vertex per face 使用 使用

表 23  テクスチャモードの説明

テテテテクスクスクスクスチチチチャモャモャモャモーーーードドドド 表表表表示示示示内容内容内容内容 意意意意味味味味

Default mapping

This IndexedFaceSet will 
be textured automatically 
using the method given in 
the VRML specification.

VRML の仕様で与えられ
る方法を用いて自動的に
テクスチャが貼られます。

1 coordinate per 
vertex

This IndexedFaceSet may 
be textured in a custom 
fashion.  Each vertex has 
one texture coordinate, even 
the vertex is shared by 
several faces.

各頂点は、複数の面に共有
されている場合でも、一つ
のテクスチャ座標を持ち
ます。

1 coordinate per 
vertex per face

This IndexedFaceSet may 
be textured in a custom 
fashion.  Each vertex has 
one texture coordinate for 
each face that uses it.

各頂点は、それを使用する
各面ごとに一つのテクス
チャ座標を持ちます。
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カラーモードの場合と同様に、テクスチャモードが変わるとオブジェクトの
見た目が変わる場合があります。オブジェクトの見た目が変化するのは以下
に示す場合です。

1 color per vertex →   Default mapping
1 coordinate per vertex per face→ すべてのカラーモード

（注）OKボタンをクリックしなければシーンは変化しません。

■■■■ Texture Mapping Projection ダイアログボックスダイアログボックスダイアログボックスダイアログボックス
図 53に示す Texture Mapping Projectionダイアログボックスでは、各投影法に
基づいてすべてのテクスチャ座標を自動的に設定できます。

図 53  Texture Mapping Projectionダイアログボックス

投影法には表 24に示す 3つの種類があります。
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投影に使用する仮想的な形状の向きは、投影する形状の VRML スタイルの
回転（x, y, z, r）で与えます。OKボタンを押すと、現在の形状に投影されます。

「Correct seam」は sphericalまたは cylindrical投影に有用です。この投影法の
場合、面がテクスチャのつなぎ目にくることがあるので、形状の左側の s座
標が右側より大きい場合があります。この問題を形状の右側に 1.0を加えて
解決します。

（注）1 coordinate per vertex モードの場合は、一つの頂点が二つの異なる値を持つ
必要があるため、正しく機能しません。

表 24  投影法の説明

投投投投影法影法影法影法 説説説説明明明明

Spherical

VRML の仕様にしたがってテクスチャマッピングされた
IndexedFaceSetを囲む仮想的な球（Shphereノード）を sとしま
す。IndexedFaceSetの各頂点 vについて、vと sの中心を通る線
を l とします。v のテクスチャ座標は、sと l の交点のテクス
チャ座標と同じになります。

Cylindrical

VRML の仕様にしたがってテクスチャマッピングされた
IndexedFaceSetを囲む仮想的な円柱（Cylinderノード）をｃと
します。IndexedFaceSetの各頂点 vについて、vとｃの中心軸
を通り中心軸に直交する線を l とします。v のテクスチャ座標
は、ｃと l の交点のテクスチャ座標と同じになります。

Planar

VRMLの仕様にしたがってテクスチャマッピングされた仮想的
な平面（IndexedFaceSetノード）をｐとします。IndexedFaceSet
の各頂点 vについて、vのテクスチャ座標は、ｖに最も近いｐ
上の点のテクスチャ座標と同じになります。
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第 15章 Object Customize Wizardの作成方法

Conductorには通常の Attributeウィンドウよりも簡単に、オブジェクトの属性を
編集できる Object Customize Wizardという機能が用意されています。選択してい
るオブジェクトがWizardに対応している場合、Attribute ウィンドウにWizardタ
ブが表示され、スライダーバー、ラジオボタン、コンボボックス、カラーピッ
カーで構成される UI によって直感的に属性を編集することができます。

図 54  Attribute ウィンドウ
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■■■■ VRML オブジェクトの変更オブジェクトの変更オブジェクトの変更オブジェクトの変更
VRML オブジェクトを Wizard 対応にするには、以下の手順にしたがって、
VRML オブジェクトに変更を加え、Wizard の設定ファイルを用意してくだ
さい。処理を行うウィンドウまたは、ポップアップメニューの選択順はカッ
コ内に示します。

1. Scriptノードを作る。（Scene Graph Window→Add Node→Common→Script）
2. Script ノードに MFString 型の wizInfo というフィールドを追加する。
（Attribute Window→ add field）

3. wizInfoフィールドに、後で作成する Wizard設定ファイルの URL を指定
する。（Attribute Window）

4. 1.で作成したTransformノードをPROTOで定義する。（Scene Graph Window
→ Create PROTO）

5. Scene Graph Window のコンボボックスで、カレントスコープを PROTO定
義部（PROTOのスコープ）にする。Wizard で変更するフィールドと、
wizInfoフィールドを ISマッピングする。（Attribute Window→map with IS）

6. PROTOインスタンスのあるタブ（bodyタブ）に戻り、すべてのノードを
消去し保存する。

■■■■ Wizard の設定ファイルの記述の設定ファイルの記述の設定ファイルの記述の設定ファイルの記述
Wizardの設定ファイルの記述は Text Editorを用いて以下のように行います。

Wizardの Windowには UI が上から順に並びます。設定ファイルには、その
順に上から UI の設定を記述します。例えば、スライダーバーをWizardの一
番上に表示したいときは、設定ファイルの一番上に [slider] と記述し、それ
に続けてスライダーバーの最大値などを記述します（「スライダーバーの設
定」（87 ページ）参照）。ラジオボタンを表示したいときは、[radio] と記述
し、ラジオボタンに必要な設定を記述します（「ラジオボタンの設定」（88
ページ）参照）。

ただし１つの Wizardに同じ種類の UI が複数ある場合、例えばスライダー
バーが２つある場合、「slider」の後ろに文字列を付け加え、[slider.1] 、
[slider_height] などとして設定ファイル内で名前が重ならないように
してください。[] 内の文字列が「slider」で始まれば、スライダーとみなされ
ます。他の UI に関しても同様です。

現在使用できる UI と識別子を表 25に示します。
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第 15章 Object Customize Wizardの作成方法
••••     スラスラスラスライイイイダーダーダーダーババババーのーのーのーの設設設設定定定定
例 ----------------------------- 

[slider.1] 
name=height 
caption="Seat Height" 
value=32 
min=10 
max=80 

------------------------------- 

表 25  UIと識別子の対応関係

UI のののの種種種種類類類類 識識識識別子別子別子別子

スライダーバー [slider]

ラジオボタン [radio]

コンボボックス [combo]

カラーピッカー [color]

表 26  スライダーバーにおける変数の説明

変変変変数数数数 説説説説明明明明

name
設定ファイル内での、スライダーバーの名前です。 
設定ファイル内で同じ名前が存在してはいけません。  
空白文字を含んではいけません。

caption
Wizardに表示される UI の名前です。 
 日本語も使用可能です。 
空白文字を含む場合は文字列をダブルクォート（"）で囲みます。

value スライダーバーの初期値です。整数のみ使用可能です。
min スライダーバーの最小値です。整数のみ使用可能です。
max スライダーバーの最大値です。整数のみ使用可能です。
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第 15章 Object Customize Wizardの作成方法
••••     ラジラジラジラジオオオオボタボタボタボタンンンンの設の設の設の設定定定定
例 ----------------------------- 

[radio_2] 
name=shape 
caption="Type of Seat" 
value=0 
option="rectangle","circle" 

------------------------------- 

••••     コンコンコンコンボボボボボッボッボッボッククククスのスのスのスの設設設設定定定定
例 ----------------------------- 

[combo1] 
name=shape 
caption="Shape of Seat" 
value=0 

表 27  ラジオボタンにおける変数の説明

変変変変数数数数 説説説説明明明明

name
設定ファイル内での、ラジオボタンの名前です。
設定ファイル内で同じ名前が存在してはいけません。
空白文字を含んではいけません。

caption
Wizardに表示される UI の名前です。
日本語も使用可能です。
空白文字を含む場合は文字列をダブルクォート（"）で囲みます。

value
ラジオボタンの初期値です。
選択肢（option）の１番が 0、２番が 1、というように対応します。

option

ラジオボタンで選べる各選択肢の説明文です。
各文字列はカンマ（,）で区切ります。
日本語も使用可能です。
空白文字を含む場合は文字列をダブルクォート（"）で囲みます。
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第 15章 Object Customize Wizardの作成方法
option="rectangle", "circle" 

------------------------------- 

ラジオボタンの設定と同じです。 

••••     カラカラカラカラーーーーピッピッピッピッカカカカーのーのーのーの設設設設定定定定
例 ----------------------------- 

[color] 
name=color 
caption="Color of Seat" 
value=0.5 0.8 0.5 

-------------------------------
  

表 28  カラーピッカーにおける変数の説明

変変変変数数数数 説説説説明明明明

name
この設定ファイル内での、コンボボックスの名前です。この設
定ファイル内で同じ名前が存在してはいけません。
空白文字を含んではいけません。

caption
Wizardに表示される UI の名前です。
日本語も使用可能です。
空白文字を含む場合は文字列をダブルクォート（"）で囲みます。

value
カラーピッカーの初期値です。
VRML と同じ RGB形式で記述します。
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第 15章 Object Customize Wizardの作成方法
••••     Wizard のののの各各各各 UIとととと VRML フフフフィーィーィーィールルルルドのドのドのドの対対対対応付応付応付応付けけけけ
Wizardの UI で入力した値を VRML に反映させるためには、UI と VRML
フィールドの対応を記述する必要があります。
UI とフィールドの対応付けは、[route] と記述した後に、基本的には左辺
を VRML フィールド名、右辺を UI に付けた名前（name）とした代入式
として記述します。この記述は、上述の各 UI の設定の記述より後（ファ
イルの最後）に行ってください。

例 ----------------------------- 

[route] 
seatTrans.y= ( height - 32 ) / 100 
poleScale.y=height * 2 / 64 
seatType=shape 
seatColor=color 

------------------------------- 

左辺には PROTOのインタフェース部分に定義されているフィールドのう
ち、SFFloat、SFInt32、SFColor、SFVec3f、SFRotation型のフィールドを記
述できます。
ただし、SFVec3f、SFRotation型は各成分に分解する必要があります。
SFVec3f型は xyz 成分に分解して記述します。例えば、上の例のように
「seatTrans.y」と記述することで、seatTransフィールド（SFVec3f型）の y
成分に右辺の値をセットできます。
SFRotation型は x、y、z、angleに分解して、例えば、「seatRot.angle」とい
うように記述します。ただし SFRotation型は「angle」をデフォルトとし
てあるので、この場合は「.angle」を省略して「seatRot」のみでも構いません。

右辺には左辺のVRMLフィールドに値をセットするために用意したUIの
名前を記述します。
左辺が SFFloat、SFInt32、SFVec3f、SFRotation型の場合、右辺には数式を
記述することが出来ます。数式には UI の名前、定数、四則演算子、カッ
コが使用できます。

なお、UIと VRML フィールドは１対１に対応している必要はありません。
つまり、１つの UI から複数の VRML フィールドへ値をセットすることが
できます。例では UI の値 heightから seatTrans.yと poleScale.yに値をセッ
トしています。
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第 15章 Object Customize Wizardの作成方法
••••     そのそのそのその他他他他
Conductorを起動した時に、Libraryウィンドウの PROTOタブにあらわれ
る VRML ファイルは、デフォルトでは Conductorをインストールしたフォ
ルダーの datalib/proto/直下にある VRML ファイルのみです。datalib/proto/
にあるフォルダー以降のVRML ファイルは Libraryウィンドウには表示さ
れません。

VRML ファイルと同じ名前で、拡張子が .bmpのビットマップファイルが
同じフォルダーにある場合、Library ウィンドウでアイコンとして使用さ
れます。無い場合はデフォルトアイコンが使用されます。
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スクリプトリファレンス
スクリプトリファレンス

ライブラリに含まれるスクリプトの詳細を説明します。

CPSCNot

DEF CPSCNot Script {
  url "scripts/CPSCNot.class"
  eventIn  SFBool   inBool
  eventOut SFBool   outBool
  field    SFString info "this is CPSCNot script."
}

inBool に対してNOT論理演算を行い、その結果を出力します。TRUEが与え
られれば FALSEを、FALSEが与えられれば TRUEを出力します。

表 29  ライブラリに含まれるスクリプト

Basic Scripts Movement Scripts Other Scripts

CPSCNot CPSCBoolVec CPSCMoveOn CPSCShowBool

CPSCAnd CPSCBoolRot CPSCMoveIt CPSCShowFloat

CPSCOr CPSCEdge CPSCMoveAlong CPSCShowInt

CPSCXor CPSCStep CPSCMoveTo CPSCShowVec

CPSCSineWave CPSCUpper CPSCRotateAlong CPSCReturnBool

CPSCToggle CPSCLower CPSCRotateTo

CPSCToggleFrac CPSCMatch CPSCFace

CPSCBoolToTime CPSCRange

CPSCFloatToInt CPSCDelayGen
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スクリプトリファレンス
CPSCAnd

DEF CPSCAnd Script {
  url "scripts/CPSCAnd.class"
  eventIn  SFBool inOne
  eventIn  SFBool inTwo
  eventOut SFBool outBool
  field SFString info "this is CPSCAnd script"
}

このスクリプトは（inOne 、inTwo ）が与えられられると、それらの AND
論理演算を行い、結果を出力します。両方が TRUE だった場合には TRUE
を、それ以外の場合には FALSEを出力します。

CPSCOr

DEF CPSCOr Script {
  url "scripts/CPSCOr.class"
  eventIn  SFBool inOne
  eventIn  SFBool inTwo
  eventOut SFBool outBool
  field SFString info "this is CPSCOr script"
}

（inOne 、inTwo ）が与えられると、それらの OR 論理演算を行い、結果を
出力します。両方が FALSEだった場合には FALSEを、それ以外の場合には
TRUEを出力します。
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スクリプトリファレンス
CPSCXor

DEF CPSCXor Script {
  url "scripts/CPSCXor.class"
  eventIn  SFBool inOne
  eventIn  SFBool inTwo
  eventOut SFBool outBool
  field SFString info "this is CPSCXor script"
}

（inOne 、inTwo ）が与えられると、それらの XOR（排他的論理和）論理演
算を行い、結果を出力します。inOne と inTwo が一致していた場合には
FALSEを、一致しなかった場合には TRUEを出力します。

CPSCSineWave

DEF CPSCSineWave Script {
  url "scripts/CPSCSineWave.class"
  eventIn  SFFloat inFloat
  eventIn  SFFloat phase
  eventIn  SFFloat amplitude
  eventIn  SFFloat waveLength
  eventOut SFFloat outFloat
  field SFString   info "this is CPSCSineWave script"
}

与えられた浮動小数の正弦値を出力します。ここで、phase は位相（0.0）
を、amplitude は振幅（1.0）を、waveLength は波長（1.0）を表します。

（注）カッコ内の数値は、デフォルト値です。
94



スクリプトリファレンス
CPSCToggle

Def CPSCToggle Script {
  url "scripts/CPSCToggle.class"
  eventIn   SFBool  inBool
  eventOut  SFBool  outBool
  field     SFBool  defBool TRUE
  field SFString    info "this is CPSCToggle script."
}

トグルスイッチです。スクリプトに TRUE が与えられるたびに、TRUE と
FALSEを交互に出力します。スクリプトが最初に出力する値は defBool で
定義でき、デフォルトでは TRUEになっています。

CPSCToggleFrac

Def CPSCToggleFrac Script {
  url "scripts/CPSCToggleFrac.class"
  eventIn   SFFloat  inFloat
  eventOut  SFFloat  outFloat
  field SFString     info "this is CPSCToggleFrac
script."
}

このスクリプトはインターポレーターをトグルするのに使います。初期状態
ではスクリプト内の変数 forward は TRUE になっています。入力された
inFloat が減少すると、forwardが TRUEと FALSEをトグルします。ここで、
もし forwardが TRUEであれば、outFloat は inFloat と同じ値を出力し
ます。FALSEであれば、outFloat は 1-inFloat を出力します。
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スクリプトリファレンス
CPSCBoolToTime

DEF CPSCBoolToTime Script {
  url "scripts/CPSCBoolToTime.class"
  eventIn  SFBool inBool
  eventOut SFTime outTime
  field SFString  info "this is CPSCBoolToTime script."
}

スクリプトが TRUEイベントを受け取ると、そのイベントのタイムスタンプ
を出力します。同時に、Java Consoleにタイムスタンプの値を double型で出
力します。

CPSCFloatToInt

DEF CPSCFloatToInt Script {
  url "scripts/CPSCFloatToInt.class"
  eventIn  SFFloat inFloat
  eventOut SFInt32 outInt
  field SFString   info "this is CPSCFloatToInt script."
}

このスクリプトは与えられた浮動小数を四捨五入した整数値を出力します。

CPSCBoolVec

DEF CPSCBoolVec Script {
  url "scripts/CPSCBoolVec.class"
  eventIn  SFBool    inBool
  eventOut SFVec3f   outVec
  field SFVec3f      vector 0 0 0
  field SFString     info "this is CPSCBoolVec script."
}

スクリプトが TRUEイベントを受け取ると、vector フィールドで定義され
た SFVec3f値を出力します。デフォルトでは、（0, 0, 0）を出力するように
なっています。
96



スクリプトリファレンス
CPSCBoolRot

DEF CPSCBoolRot Script {
  url "scripts/CPSCBoolRot.class"
  eventIn  SFBool       inBool
  eventOut SFRotation   outRot
  field SFRotation      rotate 0 0 1 0
  field SFString        info "this is CPSCBoolRot
script."
}

スクリプトが TRUE を受け取ると、rotate フィールドで定義された
SFRotation値を出力します。デフォルトでは、（0 0 1 0）を出力するように
なっています。

CPSCEdge

DEF CPSCEdge Script {
  url "scripts/CPSCEdge.class"
  eventIn  SFBool   inBool
  eventOut SFBool   outBool
  field    SFString info   "this is CPSCEdge script"
}

このスクリプトは入力の値が変わるたびに TRUEまたは FALSEを交互に出
力します。入力が変化しなかった場合（例えば、TRUEが連続して与えられ
た場合）スクリプトは値を出力しません。
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スクリプトリファレンス
CPSCStep

DEF CPSCStep Script {
  url "scripts/CPSCStep.class"
  eventIn  SFBool   inBool
  eventOut SFFloat  outFloat
  field    SFFloat  lower 0.0
  field    SFFloat  upper 10.0
  field    SFFloat  step 1.0
  field    SFString info   "this is CPSCStep script"
}

スクリプトにTRUEが入力されるたびに、lower で定義された値から upper

で定義された値まで、step ずつ増加させた浮動小数を出力します。upper

を超えると、それ以上増加はしなくなります。

例えば、デフォルト値をそのまま使用すると、最初に TRUEを受け取ったと
きスクリプトは 0.0を出力します。次に TRUEを受け取ると 1.0を出力し、
そしてその次は 2.0……と続きます。しばらくして 10.0を出力すると、それ
以上は増加しなくなり、TRUEを受け取るたびに 10.0を出力し続けます。

また、upper 、lower 、step に定義されている値と現在出力されている値
は Java Consoleに表示されます。

CPSCUpper

DEF CPSCUpper Script {
  url "scripts/CPSCUpper.class"
  eventIn  SFFloat  inFloat
  eventOut SFBool   outBool
  field    SFFloat  limit 5.0
  field    SFString info   "this is CPSCUpper script"
}

limit フィールドで定義されている値よりも大きな値が入力されるとTRUE
を出力します。入力された値が limit に等しければ、値は出力しません。

limit フィールドのデフォルト値は5.0となっており、この場合5.0より大き
い値（例えば 6.0）が入力されると TRUEが出力されます。
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スクリプトリファレンス
CPSCLower

DEF CPSCLower Script {
  url "scripts/CPSCLower.class"
  eventIn  SFFloat  inFloat
  eventOut SFBool   outBool
  field    SFFloat  limit 5.0
  field    SFString info   "this is CPSCLower script"
}

このスクリプトは limit フィールドで定義されている値よりも小さな値が
入力されると TRUE を出力します。入力された値が limit に等しければ、
値を出力しません。

limit フィールドのデフォルト値は5.0となっており、この場合5.0より小さ
い値（例えば 4.0）が入力されると TRUEが出力されます。

CPSCMatch

DEF CPSCMatch Script {
  url "scripts/CPSCMatch.class"
  eventIn  SFFloat  inFloat
  eventOut SFBool   outBool
  field    SFFloat  value 5.0
  field    SFString info   "this is CPSCMatch script"
}

このスクリプトは value フィールドで定義されている値と等しい値が入力
されると TRUE を出力します。入力された値が value に等しくなければ、
値を出力しません。

value フィールドのデフォルト値は5.0となっており、この場合5.0が入力さ
れると TRUEが出力されます。
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CPSCRange

DEF CPSCRange Script {
  url "scripts/CPSCRange.class"
  eventIn  SFFloat  inFloat
  eventOut SFBool   outBool
  field    SFFloat  upperLimit 6.0
  field    SFFloat  lowerLimit 4.0
  field    SFString info   "this is CPSCRange script"
}

スクリプトに入力された値が lowerLimit 以上 upperLimit 以内の範囲に
あるとき、TRUEを出力します。値がその範囲内に存在しない場合は、スク
リプトは値を出力しません。

lowerLimit と upperLimit のデフォルト値は、4.0と 6.0となっています。
この場合、4.0以上 6.0以下の値が入力された場合に、TRUEが出力されます。

CPSCDelayGen

DEF CPSCDelayGen Script {
  url "scripts/CPSCDelayGen.class"
  eventIn  SFTime   inTime
  eventOut SFTime   outTime
  field    SFFloat  delay 5
  field    SFString info   "this is CPSCDelayGen script"
}

SFTimeイベントを受け取ると、このスクリプトは受け取った値に delay

フィールドで指定された浮動小数を加えた値を出力します。delayフィール
ドのデフォルト値は 5.0となっています。
100



スクリプトリファレンス
CPSCMoveOn

DEF CPSCMoveOn Script {
  url "scripts/CPSCMoveOn.class"
  eventIn  SFFloat      inFloat
  eventOut SFVec3f      posChange
  eventOut SFRotation   oriChange
  field    SFString     info   "this is CPSCMoveOn
script"
}

オブジェクトの動作と回転を定義します。
デフォルトでは正弦波を描くようになっていますが、javaソースコードを編
集することによって動作を定義できます。

CPSCMoveIt

DEF CPSCMoveIt Script {
  url "scripts/CPSCMoveIt.class"
  directOutput TRUE
  eventIn  SFBool   clicked
  field    SFNode   node NULL
  field    SFString info   "this is CPSCMoveIt script"
}

このスクリプトは TRUEが入力されるたびにオブジェクトを特定の場所（ス
クリプト内で定義します）に移動させます。
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CPSCMoveAlong

DEF CPSCMoveAlong Script {
  url "scripts/CPSCMoveAlong.class"
  directOutput TRUE
  eventIn  SFVec3f   position
  field    SFNode    node NULL
  field    SFString  info   "this is CPSCMoveAlong
script"
}

ノードを新しい位置に position 分だけ移動させます。
Position Interpolatorとあわせて使うことによって、インターポレーターに沿っ
てノードを動かすことができます。

CPSCMoveTo

DEF CPSCMoveTo Script {
  url "scripts/CPSCMoveTo.class"
  directOutput TRUE
  eventIn  SFFloat   fraction
  eventIn  SFVec3f   position
  field    SFNode    node NULL
  field    SFString  info   "this is CPSCMoveTo script"
}

スクリプトが fraction を受け取ると、node フィールドで指定されたオブ
ジェクトを position フィールドで定義された場所に向かって移動させま
す。position に新しい値が指定されなければ、オブジェクトは移動しませ
ん。

（注）translation フィールドが複数存在する場合、スクリプトがどこを参照
しているかによって予想しない方向へ移動してしまうことがあります。ノード
をマウスでドラッグ移動すると新しい translationが作られます。
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CPSCRotateAlong

DEF CPSCRotateAlong Script {
  url "scripts/CPSCRotateAlong.class"
  directOutput TRUE
  eventIn  SFRotation   orientation
  field    SFNode       node NULL
  field    SFString     info   "this is CPSCRotateAlong
script"
}

このスクリプトはノードを、相対的に新しいorientation に回転させます。
Orientation Interpolatorと合わせて使うことによって、ノードを Interpolatorに
沿って動かすことができます。

CPSCRotateTo

DEF CPSCRotateTo Script {
  url "scripts/CPSCRotateTo.class"
  directOutput TRUE
  eventIn  SFFloat      fraction
  eventIn  SFRotation   orientation
  field    SFNode       node NULL
  field    SFString     info   "this is CPSCRotateTo
script"
}

スクリプトに新しい fractionが入力されると、node フィールドで指定され
たオブジェクトを orientation で定義された方向に回転させます。新しい
値が orientation に与えられなければ、オブジェクトは回転しません。
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CPSCFace

DEF CPSCFace Script {
  url "scripts/CPSCFace.class"
  directOutput TRUE
  eventIn  SFVec3f      inVec
  eventIn  SFRotation   outRot
  field    SFNode       node NULL
  field    SFString     info   "this is CPSCFace script"
}

スクリプトに新しい inVec が入力されると、node フィールドで指定された
オブジェクトを inVec の位置に向くように（例えば、円錐の場合はそちら
を指すように）回転させます。

（注）オブジェクトを正しく回転させるために、回転させるオブジェクトの
Transform ノードを確認して下さい。一度新しい Transform ノードを作成して
そちらを参照させることもできます。

CPSCShowBool

DEF CPSCShowBool Script {
  url "scripts/CPSCShowBool.class"
  eventIn  SFBool   inBool
  eventOut SFBool   outBool
  field    SFString info   "this is CPSCShowBool script"
}

受け取った論理値をそのまま出力し、Java Consoleにも表示します。このス
クリプトは、スクリプトなどに正しい値が渡されているのかを調べるために
使うことができます。
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CPSCShowFloat

DEF CPSCShowFloat Script {
  url "scripts/CPSCShowFloat.class"
  eventIn  SFFloat   inFloat
  eventOut SFFloat   outFloat
  field    SFString  info   "this is CPSCShowFloat
script"
}

受け取った浮動小数値をそのまま出力し、Java Consoleにも表示します。こ
のスクリプトは、スクリプトなどに正しい値が渡されているのかを調べるた
めに使うことができます。

CPSCShowInt

DEF CPSCShowInt Script {
  url "scripts/CPSCShowInt.class"
  eventIn  SFInt32   inInt
  eventOut SFInt32   outInt
  field    SFString  info   "this is CPSCShowInt script"
}

受け取った整数値をそのまま出力し、Java Consoleにも表示します。このス
クリプトは、スクリプトなどに正しい値が渡されているのかを調べるために
使うことができます。

CPSCShowVec

DEF CPSCShowVec Script {
  url "scripts/CPSCShowVec.class"
  eventIn  SFVec3f   inVec
  eventOut SFVec3f   outVec
  field    SFString  info   "this is CPSCShowVec script"
}

受け取った３次元ベクトル値をそのまま出力するのと同時に Java Consoleに
も出力します。このスクリプトは、スクリプトなどに正しい値が渡されてい
るのかを調べるために使うことができます。
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CPSCReturnBool

DEF CPSCReturnBool Script {
  url "scripts/CPSCReturnBool.class"
  eventIn  SFBool   inBool
  eventOut SFBool   outBool
  field    SFBool   retBool TRUE
  field    SFString info   "this is CPSCReturnTrue
script"
}

スクリプトに論理値が与えられると、入力された値には関係なく、retBool

フィールドで定義された値を出力します。
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